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Introduction 
Bearboat Pro is a successor to an earlier program simply called Bearboat 

(Bearboat Classic). This is a total rewrite of that program but retains much 

of the same “look and feel”. Bearboat Pro is largely compatible with 

Bearboat Classic. Designs that were created in Bearboat Classic can be 

opened in Bearboat Pro and it is even possible, as an option, to save designs 

created in Bearboat Pro as files that can be opened by Bearboat Classic. 

For a time, it may make sense to have both programs available for use. 

Bearboat Classic has some features that are not yet available in Bearboat 

Pro. Bearboat Pro, however, has a richer design environment and several 

features that Bearboat Classic does not have. 

Bearboat Pro is being written on a Macintosh using OS X. The ports to 

Windows and Mac OS 9 should be functional, but there are aesthetic 

problems that will persist until I have time to polish up the code for these 

specific environments. 

This program is shareware. It may be freely distributed. There is no 

charge for this program. If you ever actually build a kayak, I would enjoy 

seeing a picture of it. 

Bearboat Pro is currently under active development. I encourage people to 

send their comments and suggestions. People have already made suggestions 

that I have incorporated. Some are ideas that were simple and intriguing to 
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me. Others are ideas that I had not thought of myself but which I nonetheless 

perceive of being of value to me in the design of my own boats. If you find 

features of the program confusing, drop me a line. I may be able to help you 

and others by making the manual clearer. ANY feedback is appreciated. 

 
Robert R Livingston 
rlivingston@mac.com 
livingston@post.harvard.edu 
30221 33rd Ave SW 
Federal Way, WA 98023  
(253) 874 6199 

 

History 
My interest in kayak design started in 1967 when a teacher at my high 

school, Dwight Gibb, cajoled me into helping him make me a fiberglass boat 

for river kayaking. Once the boat was complete, he taught me the basic 

kayak skills. Many years passed before I built another kayak, but the seed 

had been planted. 

The original versions of the program that became Bearboat were written 

in 1980 on an HP computer using HP Basic. That original machine had 32K 

of memory and a built in printer that output on 3" rolls of thermal paper. It 

required approximately two weeks for the computer to calculate the data for 

an entire kayak. I could not produce full-scale drawings, so for my early 

designs I spent days in the Anchorage library plotting on graph paper the 

numeric data that was produced. The program has been rewritten three times 
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since then, each time on a different OS platform with a different language. 

Bearboat Pro is the most recent of these rewrites. 

Synopsis 
A kayak builder wrote Bearboat Pro. In this documentation, "your kayak" 

is treated as synonymous with "your design". However, this software is 

equally suited to designing a canoe. An open canoe would be designed 

simply by ignoring the deck. A closed canoe is essentially the same thing as 

a kayak as far as this software is concerned. It is quite possible to design a 

rowboat using this software; I hope some day to do just that. 

The primary output of this program is a bunch of drawings of the cross-

sections of the boat you have designed. The output is on simple 8.5 by 11 

paper or US legal paper, which is 8.5 by 14 inches. The program 

accommodates to the fact that many of the cross-sections will require more 

than one piece of paper to draw. For these larger cross-sections, you tape a 

few pieces of paper together. The actual printing process is done by a 

separate utility program called BearboatPrint that is freely available. 

The program determines the shape of the underwater section of any cross-

section of the boat by determining the minimum wetted surface that will 

enclose the area specified by the user and constrained by the waterline width 

and depth of the boat at that position. With these three values, (waterline 

width, submerged cross-sectional area and depth) there is a uniquely 

determined curve that will be drawn for that cross-section. There is logic to 

minimizing the wetted surface as this helps minimize the resistance of the 

boat moving through the water.  
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Optionally, the program provides the possibility of additional constraints 

on the individual cross-sections beyond the basic three of underwater cross-

sectional area, waterline width and depth. The designer can specify that the 

bottom of the cross-section cannot be completely flat by providing a 

minimum angle at the keel line. Similarly, it is possible to constrain the sides 

of the underwater area to an angle less than vertical. 

Overtime, I have become more interested in the character of the hull and 

deck above the water. Once you get to a “reasonable” point in terms of 

wetted surface, there are other things that are of interest in terms a designing 

a boat that meets other needs (comfort, stability, storage capacity, surfing 

performance etc.) Despite this “maturation” of my thinking, the minimum 

wetted surface curves remain valuable, and this program still rigidly allows 

only the underwater curve that is the minimum wetted surface (subject to a 

few "constraints" that can optionally be applied - see below). This is not, in 

practical terms, that much of a straightjacket. You can easily modify the 

cross-sections that this program provides. The program can get you into the 

ballpark and you can go on from here. For example, it would not be hard to 

design a chine boat from the cross-sections that this program provides. 

The cross-section profile curve of the deck and the cross-section profile 

curve of the above water sides of the kayak are decided by the user choosing 

from one of a number of “families” of possible curves. 

This methodology assures that your design will be truly smooth. There 

will not be any subtle "wows" in the contour of your boat as might occur 

with other software programs, for example ones that make use primary use 

of NURB surfaces. It also allows you to design the underwater hull almost 

separately from the above water kayak. You can optimize your below water 
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shapes and then design the upper parts of the kayak and let the software deal 

with melding them into one smooth whole. The waterline and the seamline 

are designed, to some degree, independently. 

There are many ways and materials that are used to make kayaks. In the 

past, I have made fiberglass boats and have used the predecessors of this 

program to make the plug. My own construction technique has been to cut 

out of foam the cross-sections of the boat at every 10 cm. I place these cross-

sections, appropriately spaced apart, on a straight stick the length of the boat 

and plank the result.  

It should be obvious that there are many other techniques and 

modifications that can be used. Cedar strip building techniques can result in 

incredibly beautiful and light kayaks. Bearboat Pro is quite suited to 

designing kayaks and canoes of this sort. 

The program is also capable of making reduced size models of the boat 

that you are designing. You can specify, for example, that you want cross-

sections that are 1/5 life-size to allow you to make such a model that can be 

helpful in the design process. 

A secondary type output is a computer file of numbers describing the 

cross-sections of the boat that you have designed. (width, height etc). These 

files are created as comma or tab delimited files that can be "read" by other 

programs (spreadsheets or word processors). The ability to document your 

design in this great detail is particularly useful for people who might have 

the opportunity to design more than one boat in their career. This enables 

you to compare your early designs (with whose behavior you have now 

become familiar) with later designs. This also enables you to compare your 

design with existing kayaks that have features you either like or dislike. 
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I am personally exploring creating outputs that can be used by giant 

milling machines that exist in a few places in the country to carve out a life-

size 3D copy of the boat the user has specified. I have been able to export 

the data to one of these commercial computer-milling machines and 

successfully produced a plug for my latest design. There are export functions 

that can create raw computer files that specify the shape of the kayak in 

great detail. I am interested in pursuing this further with Bearboat Pro. 

Individual designs are stored on the computer as rather small files. You 

can create and modify many different kayak designs. The smallness of these 

files makes it convenient to collaborate or share with others who have the 

program. It is easy to e-mail them or to place them on transportable media 

and transmit them this way. 

As was true in Bearboat Classic, there are four primary sites where the 

kayak is designed. These are now accessed under the Design menu. These 

four work environments are Curve of Areas, Birdview, Sideview and Cross-

Section. In general the design process starts with the Curve of Areas and 

then moves forward with Birdview, Sideview and Cross-Section. The user 

can move from any one of these areas to any of the others at anytime during 

the design process  

Installation 
In initially setting up the Bearboat Pro program, it is recommended to 

create a master folder called something like Bearboat Pro and place the 

application in that folder. As the need arises the program will create various 

folders within that master folder. Examples include BearboatDesigns and 
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BearboatPrint folders. These folders are used to store the computer files that 

produced by the Bearboat Pro program. 

The program is downloaded as a compressed file. For the PC version this 

is a .zip file and for the Macintosh a .sit or a .zip file. You have to have a 

decompression program on your machine to take the file and restore it to 

uncompressed state. Programs to do this are freely available on the web. 

Most new machines are bought with these programs already installed. If you 

need such a program, one source for a free one is StuffIt. This company has 

Windows and Macintosh versions available.  

www.stuffit.com/expander 

Bugs 
All programs have bugs. Therefore I am sure that this one does. The user 

should take the initiative to make sure that the output of this program makes 

sense before actually trying to build a boat. Make sure that the output fits 

your concepts of the boat you are trying to build. If the boat is supposed to 

be 21” wide, make sure that it is etc. It should be obvious that I cannot 

guarantee the accuracy of the output of this program. Let the user beware. 

Having said this, I am interested in squashing any significant bugs. If you 

see any anomalous (incorrect) results or strange behaviors when you are 

doing things that seem rational, please notify me so I can correct or clarify 

the situation. 
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Units of Measurement 
Metric units are used throughout, primarily centimeters. Make sure that if 

you want to design a boat that is 21 inches wide you do not end up with a 

boat that is 21 centimeters wide. As an option, Imperial measurements are 

shown next to their metric equivalents for those who are more comfortable 

with feet and inches. Imperial units can be turned on and off under the 

Preferences menu item. 

The bow of the boat is considered to be at position 0 (zero). The stern of 

the boat is at position x, where is x is the length of the boat in centimeters. 

All the measurements of where things are on the boat are based on this 

framework. 

The surface of the water is considered the zero point of the vertical plane. 

Entities, such as the height of the deck or the seam, are measured from the 

surface of the water NOT from the lowest point (bottom) of the boat. 

Terminology: Computer Interface 
This manual strives to be consistent in how it refers to the various widgets 

that are used to specify the user’s intents. These elements of the computer 

interface are commonly called controls and include such things as the slider, 

checkbox and radio buttons. The terms that are frequently used in the 

manual are defined below. 

WINDOW OR ENVIRONMENT 
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The program basically consists of many different windows 

(environments) that provide the controls that let the user design or view 

various aspects of the kayak. Choosing items in the main menus usually 

specify the different windows. 

For example, there is a Sideview window that allows specification of the 

parameters that determine the side profile of the kayak. 

DATA ENTRY BOX 

Data entry boxes allow the user to type in values for the program to use. 

An example would be the data entry box that accepts the name of the kayak 

being designed in the Save window. You can also specify the length of the 

kayak by typing it in a data entry box. 

LITTLE ARROW 

Little arrows are paired buttons that allow you to increase or decrease a 

value by a discreet amount. A single click will increase or decrease a value 

by one unit. To increase the flexibility of this control, Bearboat modifies the 

behavior of the button when the Shift key is held down. This results in the 

increment value being greater so the value changes to a greater extent in 

response to a single click. Holding both the Shift key and the Control key 

down simultaneously will further exaggerate the effect of a single click. In 

Bearboat Pro, little arrows are frequently found just to the right of data entry 

boxes to allow an alternative way to change the value of a parameter. 

SLIDER 
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Sliders are commonly used to select a value from a spectrum of values. 

Bearboat Pro, for example, uses sliders to specify the placement of location 

lines on graphics. These placements can range between the bow and the 

stern of the boat. Sliders allow the user to choose values in a range between 

a high and a low value. 

RADIO BUTTON 

Radio buttons seen on the window as a group. They allow the selection of 

a single choice among many. 

CHECKBOX 

Checkboxes allow an option to be either selected or not. 

TAB PANEL 

Tab panels allow conservation of space, grouping controls on panels that 

are revealed by clicking on the tabs. The user alternately accesses the groups 

of controls by clicking on the appropriate tab. 

COLOR SQUARE 

Color squares serve several functions. A label generally identifies them 

and they indicate on accompanying graphics, by sharing the same color, the 

entity with which they are associated.  

In many contexts, clicking on a color square causes the entity to appear on 

the graphic in the first place. In the Curve of Area window, clicking on the 

pink color square labeled Center of Buoyancy, indicates by a pink line the 
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location of the Center of Buoyancy. If you are a synesthete, and believe that 

the Center of Buoyancy should be a different color, you can Shift-click on 

the square to choose a color you like.  

The color of a color square can be changed by holding down the Shift key 

while clicking on a color square. This will bring up a tool that allows 

choosing an alternate color. 

CANVAS 

Canvases are the areas in the window that show the graphics and pictures. 

Often Bearboat allows clicking on the picture itself to accomplish certain 

tasks, for example, establishing a particular location of interest on the kayak.  

GROUP BOX 

Group boxes are labeled rectangles on the window that group various 

controls to help organize the use of the window. 

POP UP MENU 

Pop-up menus provide a list of options that “pop-up” (actually usually 

down) when you click on the control. Only one of the options on the list can 

be selected at any given time. 

Terminology: Kayak Descriptors 

DECK LINE 
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The line running the length of the boat in the midline connecting the 

highest point of every cross-section 

KEEL LINE 

The line running the length of the boat in the midline connecting the 

lowest point of every cross-section 

SEAM LINE 

The lines running along each side of the boat connecting the widest point 

of every cross-section 

DESIGN WEIGHT 

The user designs a kayak effectively specifying a particular weight that 

determines where the waterline of that boat will be.  

WATERLINE 

This is the line running along each side of the boat where the surface of 

the water is when the kayak is at its design weight. Used in some contexts as 

synonymous with the greatest depth of the boat.  

WATERLINE WIDTH 

This is the distance between the waterlines on each side of the boat, i.e. 

the width of the boat at the waterline. With a boat constructed using this 

program, the waterline width at any point is less than (or rarely equal to) the 

seam width at that point. 
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DECK HEIGHT 

The distance from the highest point of the deck to the surface of the water 

is considered the deck height. Deck heights vary along the length of the boat. 

DRAFT 

Distance from the bottom of the boat to the surface of the water at the 

deepest point of the hull is considered the draft. The deepest point of an 

individual cross-section is often referred to as its draft (or depth). The drafts 

are expressed as positive numbers for the submerged part of the boat. Where 

the keel line is above the waterline, (at the bow and stern) the draft is 

expressed as a minus number.  

DEPTH 

Depth is synonymous with draft in this manual. 

SEAM WIDTH 

Distance between the two seam lines at any given point, which is the same 

thing as the width of the boat at that point. 

SEAM HEIGHT 

Distance of the seam line above the surface of the water. 

BOW SEAM HEIGHT 

Distance of the bow of the boat above the surface of the water 
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STERN SEAM HEIGHT 

Distance of the stern of the boat above the surface of the water 

POSITION 

Distance, in centimeters, from the bow of the boat. 

ENTRY (ENTER) 

Position near the bow where the keel line enters the water 

EXIT (LEAVE) 

Position near the stern where the keel line leaves the water 

WATERLINE LENGTH 

Length of the part of the boat that is in the water (Exit - Entry) 

WETTED SURFACE 

As applied to a boat, this is the area of the boat that is in contact with the 

water. It would be expressed in centimeters squared. I also apply this term to 

an individual cross-section. In this context, it is the length of the line of that 

cross-section which is in contact with the water and would be expressed in 

cm. 

MINIMUM KEEL WIDTH 

This is a minimum width that the boat hull can attain. This assures that 

keel-like structures are thicker than the specified minimum. 
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MINIMUM SEAM WIDTH 

This is a minimum width that the boat can attain at the seam line. This 

assures that the ends of the boat are not knife-edges. For many methods of 

construction this is not particularly important as "real-life" will prevent 

knife-edges. 
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MENU BAR 
The functions of the program are available through the menu bar. This 

next section of the manual simply goes through the menu bar and explains 

all the menus and menu items, and the work environments that they contain. 

TOOL 

Tool: Restore Default Colors 

This function is not implemented in this version of Bearboat Pro 

Tool: Drag Spreadsheet 

Matt Broze has created a spreadsheet, available on the Mariner Kayaks 

web page ( www.marinerkayaks.com) , which analyses aspects of kayak 

performance given the values of various parameters. The Drag 

Spreadsheet menu item accesses a window that summarizes the data for 

your design that can be entered in this spreadsheet should you care to take 

advantage of it. I have placed in green data entry boxes all the parameters to 

carryover into the spreadsheet. These values can be cut and pasted into the 

spreadsheet.  

It is tedious to individually enter all these values. There is one data entry 

box on this window in a group box labeled Cut and Paste into Drag 

Spreadsheet. If you copy ALL the text from this data entry box, you can 
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paste this entire thing into the cell A9 of the spreadsheet to save the bother 

of individually entering many of the parameters. Copy and Paste are 

commands in the Edit menu. Highlight the text in this data entry box so it 

can be copied and pasted. 

The spreadsheet is very useful in that it not only allows you to see the 

predicted performance characteristics of your kayak, but it also allows you 

to compare your design with several other kayaks that Broze has included in 

the spreadsheet. 

Tool: Particulars 

The window associated with this menu item will show many of the values 

that characterize the kayak's hydrostatics. People familiar with the use of 

these terms might find them helpful, perhaps to compare the design with 

others. Some of these concepts are a little arcane. There is a nice web site 

www.oneoceankayaks.com/smhydro/hydro.htm that provides clear 

definitions for most of these hydrostatic terms.  

There is a button, Summary Data To File, on this window that will create 

a file which is placed in a folder called BearboatParticulars. Programs such 

as Excel or Word can open this file. This file will provide the particulars and 

other summary information about your design. It can be useful for reference 

when trying to compare a new design with a prior. 

Tool: Constrain Cross-Section 

This window allows specification of additional constraints on the 

computer's construction of the underwater cross-section. With no additional 

constraints, the computer will relentlessly create the cross-section with the 
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minimum wetted surface given the basic requirements of creating a cross-

section of a given area, depth and width. 

With no additional constraints, certain cross-sections may have a 

completely flat bottom and certain cross-sections may have completely 

vertical sides. There is nothing intrinsically wrong with either of these two 

things, but it is possible to constrain the program to prevent them. The water 

angle is that angle that the side of the underwater cross-section makes with 

the water surface. Vertical would be 90 degrees. This can be constrained to 

some lesser value. The keel angle is that angle that the bottom of the boat 

makes with the vertical in the midline. If the boat were completely flat in the 

midline that angle would be 90 degrees. This can be constrained to some 

lesser value that will assure that there is a definable keel line that runs the 

entire length of the boat and that the boat is nowhere flat on the bottom. 

Some designers prefer this. A slight angle at the keel line helps to stiffen the 

boat, which some construction materials will require. The program does not 

allow values of less than 60 degrees for either of these parameters. 

The water angle can be additionally constrained by checking the box 

Underwater Angle Constrained by Side Angle. The side angle is determined 

by the height of the seam and the overhang (the difference between the 

width of the seam line and the width at the water). Normally, the underwater 

shape of the boat is totally independent of these variables. The effect of this 

independence is that there can be a concavity at the waterline under some 

circumstances. In other words, when looking at the cross-section, it is 

possible that the side of the underwater part of the curve is more vertical 

than the side of the over the water part of the curve. Most commercial 

designs will not show cross-sections of this type from which we can 
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conclude they are not popular although I prefer them under some 

circumstances. In any case, to avoid this, check the Underwater Angle 

Constrained by Side Angle checkbox. This constrains the shape of the 

underwater part of the curve to be no more vertical than the line between the 

seam and the side of the boat at the waterline. There are limitations on the 

power of this constraint. It will not force the underwater side to be less 

vertical than 60 degrees. 

It is possible to "increase" this constraint by a few degrees by using the 

little arrows that appears when this constraint is checked. This is primarily 

useful if you have chosen to use Bezier sides. The final form is dependant on 

the degree of overhang at the cross-section, the chosen side type (Bezier, 

Hollow, or Straight) and the other parameters that are chosen. 

In the figure below, the top cross-section is not constrained, and there is a 

slight concavity at the waterline. The bottom cross-section has been 

constrained by the side angle, and there is no concavity at the waterline. This 

illustration is from a setting where Straight sides have been chosen. The 

effect of this constraint is clearest in this situation. As discussed in the 

previous paragraph, the situation is more complex when Bezier sides have 

been chosen. 
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A data entry box will accept a value for Area Too Small to Determine the 

Water Angle. In general, this should just be left at the default of 15. This 

parameter ensures a smooth the transition of the cross-sections of the boat as 

they emerge from the water at the bow and the stern. 
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It is difficult to explain the effect of this parameter but it is not difficult to 

demonstrate. Take the Generic boat and in the cross-section area make 

Start = 2 

End = 50 

Interval = 2 

Then click the Clear/Draw button. The cross-sections will meld with 

each other very smoothly. Now go to the constraints area and change the 

Area too Small to Determine the Water Angle to zero. Now go back to the 

cross-section area and try drawing the same segment of the boat. You will 

see a region near where the boat is exiting the water where the cross-sections 

do not appear to be blending together well. 

This occurs because when the cross-sectional area becomes very small the 

angle at which the underwater section emerges from the water becomes very 

sensitive to tiny changes in the parameters. Thus adjacent cross-sections can 

have considerably different angles and this causes the above water sides of 

the boat to vary in their appearance, particularly when Bezier sides are 

chosen. By making the value of Area Too Small to Determine the Water 

Angle 15, the program uses an alternate method to calculate this angle when 

the cross-sectional area falls below 15 which assures a more rational 

behavior. You may find for some design that a value greater than 15 is 

required to deal with this "instability" but generally 15 should do the job. 

If you have designs created with versions prior to 10/31/99 in Bearboat 

Classic, you should consider modifying them by changing that parameter 

from zero to 15. 
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There are two canvases in this Cross-Section Constraints window. The 

upper one shows a cross-section of the boat. The lower one is a 

representation of the kayak that shows where the cross-section lies. There is 

a slider associated with this lower graphic that allows choosing any arbitrary 

location. In place of using the slider, it is possible to click on the kayak 

graphic. The cross-section corresponding to the location clicked on will be 

chosen. 

The cross-section graphic shows in water color the area in which the 

cross-section can exist. As the Maximum Water Angle or the Maximum Keel 

Angle constraints are applied this area becomes more constricted to illustrate 

their effect. By using the slider, the potential effect on any cross-section of 

the boat can be demonstrated. To actually, force the cross-sections to 

conform, click on the Apply New Constraints button. Exiting this window 

will also act to enact the constraints that have been specified. 

Tool: Restore Generic Kayak… 

The program uses an arbitrary set of values as the "starting point" for the 

user. This menu item simply restores these initial values. If the designer has 

specified other parameters, they will be replaced by the default values. If 

you wish to be able to restore the values as they currently exist, remember to 

save your kayak design before using this menu item,. 

The Generic Kayak is not any "real" design. It just is a set of parameters 

that can start you on your way to your own design. 
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Tool: Wetted Surface 

Bearboat Pro will create, for any given cross-section, the minimum wetted 

surface within the constraints that are imposed by the designer. This tool is 

for designers for whom minimizing the wetted surface is a priority. The 

window will show what the total wetted surface for the design is and 

compare it with the “ideal” design where every cross-section is a hemi 

circle. Once the underwater length of the boat and the curve of area have 

been specified, there is only one minimum wetted surface design, that with 

every cross-section a hemi circle. This window will compare your design 

along its length with this “ideal” design. It will, in general, not be the same 

because you have imposed additional constraints such as the Birdview 

waterline and the Sideview rocker. 

The top graph shows the wetted surface of the design at hand in black and 

compares it to the “ideal” wetted surface in red. The wetted surface of a 

point on the kayak is taken to be the length of the edge of the underwater 

part of the cross-section. The second graph shows the magnitude (in 

arbitrary units) of the difference between the design and the “ideal”. This 

just shows the relative magnitude of the discrepancy along the length of the 

boat. 

Below, you can use the slider and little arrows controls to query in detail a 

specific cross-section at a specific point on the kayak. There is a graphic on 

the lower right that will show this cross-section and compares it with the 

hemi circle that contains the same underwater area. 

There are very good reasons NOT to have every cross-section an exact 

hemi circle. There are other considerations in design, for example stability, 
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that may override the use of pure hemi circles. Nonetheless, this window can 

provide useful information for refining a design. 
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DESIGN 

Design: Curve of Areas  

As the kayak is designed, the user can go back and forth between Curve 

of Areas, Sideview, Birdview and Cross-Section. It makes the most sense to 

start with the Curve of Areas although some may find this a little abstract. 

This is a curve created by drawing a graph of the underwater area of the boat 

(y axis) vs. the position from the bow to the stern (x axis). The smoothness 

of this graph assures that the boat will have a smooth shape as it start thin 

and small at the bow, expands to a point somewhere near the center of the 

boat and then tapers toward the stern. This curve determines a host of 

parameters that characterize your design such as the displacement, center of 

buoyancy and the prismatic coefficient. 

There are a number of parameters that determine the shape of the curve of 

areas. Entry and Leave define the waterline length and determine where the 

keel line enters and leaves the water. The Maximum Area is the size of the 

largest cross-sectional area. The Location of Max Area is the position of this 

largest cross-sectional area. The Length is just the overall length of the boat 

and is less important here as the curve of areas is primarily concerned with 

the underwater length. 

There are 4 arbitrary parameters that can be adjusted to affect the shape of 

the curve. Many of the curves in this program use this technique. The first 

parameter affects primarily the first quarter of the curve while the second the 
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second quarter etc. As the number increases, that part of the curve becomes 

“fuller”. By default, the left side of the graphic is the bow and the right the 

stern. 

The curve of areas determines many of the properties of the boat. Any 

reasonable curve of areas will produce a reasonable boat. Here you can 

decide how fine the entry of the boat will be. Here you decide the weight 

capacity of the boat. The center of buoyancy and the displacement of the 

boat are all determined by the curve of areas. The prismatic coefficient is 

determined by the curve of areas. 

The Curve of Areas window has a canvas in the lower right corner that 

shows a single cross-section of the kayak at a particular location. Values 

associated with that cross-section are also presented. This cross-section is at 

the location written in the nearby data entry box. The location line simply 

refers to a vertical line drawn on the graphic that corresponds to a particular 

chosen location. This will be drawn on the main canvas if the Show 

Location Line checkbox is selected, 

There are many ways to change the specified location, A slider and little 

arrows and a data entry box are all provided for this purpose. If the Show 

Location checkbox is selected, then location can also be specified by 

clicking on the main canvas that contains the curve of areas, The windows 

for Birdview and Sideview also treat the location specification in the same 

way, 

There is a checkbox Show Max Limit. If this is activated, it indicates the 

upper bounds of what cross-sectional area is possible at any given point 

along the boat. It displays as a pale red zone. If your curve of areas moves 

into this "red zone" then you are asking the "impossible". 
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This issue is discussed elsewhere in this manual, but basically there is an 

upper limit of underwater cross-sectional area that can be accommodated by 

a kayak of any given waterline width and depth. This is not that complex to 

understand. Let's say there is a point along the length of the boat that has a 

waterline width of 50 cm and a depth of 10 cm. It is not going to be able to 

accommodate a cross-sectional area of greater than 500 cm2 (10 cm * 50 

cm). That would be a rectangular underwater cross-section. If you "ask" for 

more than this in the curve of areas module, then later you are going to have 

to change other parameters in other modules (primarily the width and or 

depth of the boat) You cannot expect to specify a boat 16 feet long, 21 

inches wide with a draft of 2 inches and expect it to carry 900 lbs. The curve 

of areas module does not prevent you from creating whatever curve of areas 

you want, but if you do not adjust other parameters when you find yourself 

in the "red zone" then the cross-sections will be "impossible". You will see 

this when you try and visualize the cross-sections in the cross-section 

module. 

As changes are made, they accumulate on the graphic. To refresh the 

graphic and erase all the accumulated lines, click on the Refresh button. 

Alternatively, tap on the space bar of the keyboard. This "clean-up" method 

is used throughout the program. 

In Bearboat Pro, one will see a number of small colored squares in the 

design areas. Frequently one can click on the squares to demonstrate 

something on the graphics of that page. For example, one can click on the 

square to the left of Location of Max Area to demonstrate that location. 
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If one wishes to change the default colors for any of the squares, one can 

click on the square while holding down the Shift key. This will allow you to 

choose a custom color for, as an example, the Center of Buoyancy.  

The Original Curve button allows the user to see the curve on the boat as 

it existed when the user first selected the Curve of Areas menu item. This 

can help orient the user to where she started if the accumulation of changes 

has become confusing. 

It's also possible, when in the Curve of Areas window, to superimpose a 

Birdview or a Sideview of the kayak being designed. 

Design: Birdview 

Allows the user to view the boat under design from the top. Here the user 

provides the parameters that determine the width of the waterline and the 

width of the seam line along the length of the boat. This program assumes 

that the seam width at any point is greater than or equal to the waterline 

width. Occasionally boats are designed that do NOT obey this rule. In canoe 

design, it is called tumblehome. This program will not allow entering values 

that result in the waterline width being greater than the seam width. 

The waterline is displayed in blue. The seam line is displayed in black. 

There are 4 arbitrary parameters that can be adjusted to affect the shape of 

the waterline and 4 arbitrary parameters that can be adjusted to affect the 

shape of the seam line. Many of the curves in this program use this 

technique. The first parameter affects primarily the first quarter of the curve 

while the second the second quarter etc. As the number increases, that part 

of the curve becomes “fuller”. By default, the left side of the graphic is the 
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bow and the right the stern. Click the Refresh button or tap the space bar to 

get rid of all the extraneous lines that accumulate. 

The canvas in the right lower corner shows a specific cross-section of the 

kayak. The location in indicated in the data entry box that is seen to the left. 

If the checkbox, Show Location Line, is selected, then a vertical line 

corresponding to the main location will be shown on the main canvas. To 

see where position 300 is, enter this value in the data entry box and then 

TAB out of it. An orange line will indicate this position on the graphic. 

The half angle of entry and half angle of exit are values that are of use to 

some kayakers trying to optimize their design. This is a measure of how fine 

the bow (or stern) is at the waterline. Clicking on the appropriate colored 

squares will result in graphics indicating these values being projected on the 

picture.  

The Minimum Keel Width parameter forces the kayak to have a minimum 

width at all points to the underwater cross-section (i.e. there are no knife 

edges at the bow or stern or at the keel line. This is to further a goal of mine 

of producing output that can be used by a computer driven 3D milling 

machine. This function is not very relevant for someone intending more 

conventional construction techniques. Knife-edges will be suppressed by the 

nature of the material of which the boat is being constructed. 

The Minimum Seam Width parameter forces the kayak to have a minimum 

width at the seam. It is impossible to have a Minimum Seam that is narrower 

than the Minimum Keel. Again this function is not very relevant for someone 

intending more conventional construction techniques and under those 

circumstances may not be worth bothering with. 
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Remember when using the little arrows that each click’s effect can be 

magnified if you are holding down the Shift key or both the Shift key and 

the Control key. For example, clicking on the Maximum Waterline Width 

little arrows will change the value by only 1 mm. If you hold down the Shift 

key, a single click changes the value by 1 cm. 

Design: Sideview 

The Sideview window allows the user to view the boat under design from 

the side. Here is provided the parameters that determine the draft (depth of 

the keel), the height of the deck and the height of the seam line along the 

length of the boat. 

There are 4 arbitrary parameters that can be adjusted to affect the shape of 

the seam line and 4 arbitrary parameters that can be adjusted to affect the 

shape of the keel line. Many of the curves in this program use this technique. 

The first parameter affects primarily the first quarter of the curve while the 

second the second quarter etc. As the number increases, that part of the 

curve becomes “fuller”. By convention, the left side of the graphic is the 

bow and the right the stern. The Refresh button will remove extraneous 

lines that may have accumulated. 

In this module, you are determining the seam line as seen from the side. 

This program assumes that the seam line is straight or that it dips down in 

the middle. Occasionally boats are designed with what is called reverse 

sheer. The seam line (sheer line) of these boats is higher in the center than it 

is at the ends. This program does not support this sort of seam line. The 

seam line is determined by the parameters in the Shape Seam group box. 
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The keel line is determined by the parameters in the Shape Rocker group 

box. The boat profile at the bow and stern of the boat (the part that is out of 

the water) is arbitrary. I have selected mathematical formulas that create a 

curve that I happen to like over a wide range of values. But really, this is in 

the hands of the builder. 

The bow (and stern) of a kayak are small and easily modified. Much of 

the character and aesthetics of a kayak come from how these elements are 

treated. I consider this really to be outside the bounds of the computer 

program. This is where the sculptor and the artist hold sway. When building 

a boat, I generally recommend that designers deal with the bow and the stern 

last and integrate these elements in with the rest of the boat. A beautiful bow 

can make an ordinary boat shine. 

The deck line is handled somewhat differently. Using the controls in the 

Add Deck Specification group box, provide as many values of the deck 

height as are desired and the program connects them with lines. This 

determines the height of the deck at any point. Remember the height 

measurements are from the surface of the water and NOT from the bottom of 

the boat. These lines can be smoothed, to varying degrees, using the 

Flat/Angular slider. 

In Bearboat Classic, it was possible to specify some parameters, such as 

the draft of the boat, only as an even centimeter. This restriction has been 

lifted with Bearboat Pro. It is now possible to specify the draft to the nearest 

millimeter. One can test this by directly entering data into the data entry box.  

Clicking on the little arrows that lie just to the right of the data entry 

boxes will change their value. Clicking on the up arrow will increase the 

draft by 1 mm. Clicking on the down arrow decreases it by 1 mm. The 
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convention used in Bearboat Pro is that these little arrow controls act with 

greater force if the Shift key is held down while clicking on them. Holding 

the Shift key down while clicking on the up arrow next to the draft data 

entry box will increase its value by a full centimeter.  

With some of the little arrow controls, holding down the Shift key as well 

as the Control-key will further magnify the impact of clicking on one of the 

arrow buttons.  

Design: Cross-section 

The Cross-Section window has shown considerable change since the prior 

Bearboat Classic version. The window is activated under the Design menu, 

but this environment is equally important as a tool to simply visualize your 

kayak. The only part of this window that actually changes the design of the 

boat, is contained in the Side and the Deck group boxes. Here you can 

change the family of shapes that are applied to the sides and a deck of the 

kayak. 

The program minimizes the wetted surface to determine the underwater 

cross-section, but it is arbitrary how the waterline is to be connected to the 

seam line and the seam line to the deck line. For this purpose, the user 

chooses from the families of curves that are available to determine the shape, 

as seen in cross-section, of the sides and deck of the boat. You choose one 

family for the side and one family for the deck and that is applied to the 

entire boat. This gives an aesthetic unity to the craft.  

For the deck, I have always used Semi-Ellipse, which has worked well for 

me. Others like a more peaked deck and I have provided other options to 

allow for this.  
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For the side, the default is Bezier. If Bezier is selected, a slider appears 

that allows modification of the Bezier curve of the side of the boat. Moving 

the slider to the right tends to make the curve "fuller" while moving them to 

the left makes the curve "flatter". Bearboat Classic has two sliders for this 

purpose, one of which primarily affects the curve closer to the deck and the 

other the curve closer to the water. Having two sliders is an option that can 

be restored as a preference in the Preferences window. You might think 

that the Straight option would produce an angular looking craft, but this is 

not really the case. Many commercial kayaks, in fact, have flat sides but 

because of the curves in the third dimension and changes in angulation, this 

is not easily perceived. 

Underneath the main canvas are the controls to look at a single cross-

section anyplace along the length of the boat. There is either a birdview or 

sideview of the kayak in a canvas in this area. You can click anywhere on 

this graphic to show the corresponding cross-section. Sliders, a data entry 

box, and little arrows are alternative ways of selecting the location of 

interest, 

It is possible to have made incompatible choices in the other design 

windows. It is to ask for a cross-sectional area at a given point that is larger 

than can be achieved with the depth and waterline width chosen for that 

same point. The program will indicate this by drawing the underwater cross-

section in red and appending a triangle shape to the underwater area. These 

conflicts can be resolved by making the cross-sectional underwater area 

smaller here in the Curve of Areas module or by increasing the depth in the 

Sideview module or increasing the waterline width in the Birdview module 

or some combination of the above. The Generic boat has some 
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"incompatible" values at the very bow of the boat. These will display in red. 

One could chase these down by modifying some combination of parameters, 

but in these particular locations they are not very important. A couple of 

strokes with a sander in the "real" world will take care of them. You need 

not be very concerned with red cross-sections that appear very close to the 

bow or the stern. 

There are three pop ups on the right mid portion of the design area. The 

first and second determines how much of the cross-section will be shown. 

The third determines the “look” of the cross-sections. 

The first pop up defaults to Deck & Hull which refers to the fact that , 

with this setting chosen, the cross-section image of the boat will includes 

both the deck and the hull. It is possible to choose Deck Only, which uses 

the available space to only show the deck portion of the kayak. Similarly one 

can elect to see only the Underwater Only portion of the kayak with a third 

option. These various choices allow more magnified looks at part of the 

kayak  

The second pop-up control defaults to Bilateral. That is to say that one 

sees both the right and left side of the kayak. Other choices under this pop-

up allow you to see only one side of the kayak allowing potentially further 

magnification, Unilateral. Is also possible to see a series of cross sections of 

the boat with the sections toward the bow shown to the left and the sections 

toward stern shown to the right, Bow Lt, Stern Rt. 

The third pop-up acts only when multiple cross-sections are being shown. 

This pop-up defaults to Transparent. When multiple cross-sections are 

being displayed, each of the cross sections being shown is superimposed on 

all the others and all are equally visible. Opaque: Bow and Opaque: Stern 
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show the cross-sections with those cross-sections “behind” other cross-

sections being obscured. If the Fog: Bow option is chosen, then the cross-

sections toward the stern are not invisible but rather appear fainter as though 

partially obscured by fog. The final option, Contour, assigns colors to the 

cross-sections as though they were contours on a map. You might find this 

more colorful than useful. 

To illustrate the effect of these three pop ups on the images, click on the 

Clear/Draw button that maybe seen in the group box entitled Multiple 

Sections in the right lower corner of the page. Nothing really happens until 

this button is clicked on. 

 This Multiple Sections group box allows you to determine exactly which 

sections of the kayak are going to be draw. Provide the start cross-section, 

the last cross-section and the interval at which intervening cross-sections are 

to be drawn. Then click on the Draw button or the Clear/Draw button. With 

the latter, the existing graphic is cleared before the new graphic is drawn 

showing the cross sections that have been specified. 
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VISUALIZE 

Visualize: Slice 

This opens the Slice window, which provides another way of looking at 

the kayak. This is purely for visualization purposes. None of the actual 

parameters of the kayak can be altered in this area. The Design menu items 

provide the tools for actually creating and modifying the kayak.  

In the Design Cross-Section window, the kayak is seen as a stack of 

cross-sections, slices if you will, that are oriented perpendicular to the long 

axis of the boat. There are, of course, other ways to cut the kayak and the 

Slice window contains three canvases that show common alternatives. These 

are helpful in understanding the three dimension characteristics of the boat 

as seen on a flat screen.  

The top canvas, labeled Deck, shows horizontal cuts through the deck as 

though viewed from above. Slices that are taken in the horizontal planes 

through the hull are commonly called waterlines and these are shown in the 

second canvas, which is labeled Hull. Here the kayak is being viewed from 

below. Slices made in a vertical plane parallel to the fore and aft line are 

called buttock lines and these are shown in the third canvas labeled Side  

As the Slice window first opens, these graphics are shown in arbitrary 

single colors. Each graphic is associated with a color square. Shift-clicking 

on the square provided the ability to change to another color. 
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Each graphic also is associated with a slider to control the thickness of the 

individual slices (or you might think of this as the space between the slices). 

This allows showing an arbitrary “density” of slices on the graphic. 

Slice images can be considered to be contour maps. Such maps are 

created, in a sense, by “slicing” the topography of the earth into horizontal 

slabs the outlines of which are drawn. To accentuate the “height” on such 

maps, a color scale can be added. Bearboat Pro allows you to visualize the 

buttock lines etc. as though they were contour lines. A pop-up allow you to 

alternate between monocolor, contour colors and various multicolored 

options. 

Checkboxes are provided for the Hull and Side graphics to add water and 

show the design waterline. The default pale blue may not be dark enough for 

some tastes. Remember, the color can be changed by Shift-clicking on the 

appropriate color square. 

Visualize: 3D 

Here your design can be visualized in 3D space from any angle. This is 

simply for visualization purposes. No changes to the design can be made in 

this area. 
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There is a lot of color work in this environment. An infinite number of 

color schemes can be specified. Computers with graphics cards that allow 

specification of many colors will provide a “smoother” look. Default colors 

are scattered around through this window. To customize a color, click on the 

little color square with the Shift key held down and any color supported by 

your computer can be chosen. This methodology is shared with the rest of 

Bearboat Pro.  

In Bearboat Pro, it is possible to increase the size of the display window if 

your monitor has some extra space. This will allow you to see your kayak in 

more detail. Most of the windows in Bearboat Pro share this capability. It is 

most useful in the windows that are displaying your design for visual 
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analysis. Grab the lower right corner of the window and drag it in order to 

enlarge it. 

The little arrows in the Move group box specify the orientation of the 

kayak in space. The default opening position is the kayak facing the viewer 

bow on. The Heel little arrows will tilt (or heel) the kayak around its long 

axis. The kayak can be tipped 90 degrees in either direction. The Up/Down 

little arrows will lift or depress the bow, rotating the kayak in the vertical 

plane. The kayak can be rotated so that the stern or the bow sits vertically 

underneath the other end (-90 to 90 degrees). The Right/Left little arrows 

will push the bow to the right or the left, rotating the kayak in the horizontal 

plane up to 180 degrees. To look at the boat from the stern, you rotate it in 

the horizontal plane 180 degrees as though it were sitting on a lazy susan. 

It is important to remember some of the shortcuts that are universal in 

Bearboat Pro. Little arrows are used to specify the angles at which the kayak 

is to be viewed. A single click on one of the little arrows will change the 

perspective by only one degree. Click with the Shift key down will result in 

a greater change. Click with the Shift key and the Control key down will 

result in a yet more dramatic change. To return to the default values, click on 

the words that label the little arrows. For example, clicking on Heel will 

return the kayak to the upright position from whatever degree of heel it has 

been placed. Clicking on Right/Left will return the bow of the boat to face 

the viewer. Shift-clicking on Right/Left will actually spin the boat 180 

degrees so it is being viewed from the stern. 

It is also possible to move the kayak by clicking and dragging in the 

canvas itself. At the onset, the closest part of the kayak is in the foreground. 

Click somewhere near the bow and “move” it by dragging a little to the right 
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or left or up or down. When you let go of the mouse, the kayak will move in 

the direction that you dragged the mouse. Playing with this feature will 

“explain” it more easily than words. It is the easiest way for most people to 

examine the kayak from various perspectives. It is useful to remember, if 

you get “lost”, to click on the Right/Left label to bring the bow back to 

facing the viewer and on the Up/Down label to bring the boat back to the 

horizontal plane. While this interface allows moving the kayak by dragging 

in the canvas, heeling the kayak can only be done with the little arrows or by 

dragging the appropriate part of the Axis control. 

The final way to move the kayak is by using the Axis control. The Axis 

control consists of three circles. There is a little dot on the circumference of 

each circle that reflects how the kayak is positioned. As the bow of the 

kayak is tilted up or down or to the right or to the left, the little dots moves 

to provide a graphic representation of the current position of the kayak. 

Conversely, it is possible to control the angle of the kayak by clicking and 

dragging on the little dots themselves. This is the easiest way to quickly 

specify the degree of heel of the kayak. 

In the lower right part of the window are the controls that determine 

which and how many cross-sections are being viewed. It is possible to look 

at only a short segment of the kayak. The “density” of the cross-sections can 

be adjusted with the Interval little arrows. This is the same interface that is 

used in the Cross-Section area in the Design menu.  

The “look” of the kayak is largely determined by the controls that sit in 

the tab panel that occupies the upper right of the window. The 3D form may 

be considered to be a stack of cross-sections suspended in space. To varying 
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degrees, this can create the illusion of a 3D solid. If the interval between the 

slabs is small, this may heighten the illusion.  

The individual cross-sections have an edge and an interior. The color of 

the edges is determined by the controls in the Edge panel. The color of the 

interior is determined by the controls in the Fill panel. It is possible to show 

or not show either the interior or the edges. When the 3D window first 

opens, all of the edges are shown (Deck, Side, Hull) and all of the interiors 

are shown (Deck, Side, Hull). This is controlled by checkboxes in the 

respective tab panels. Experiment with making the interiors transparent by 

unchecking Deck or Side or Hull or all three in the Fill tab. Different settings 

show different features to advantage. 

In general, making the interiors opaque with the fill function makes the 

3D illusion easier to appreciate while at the same time it obscures detail. 

(The contours of the kayak on the “far” side become obscured.) 

It is possible to get confused as to which elements you are changing. Try 

and stay aware of whether you are working with the Edge or the Fill. 

A few checkboxes are provided that can help the 3D illusion or at least aid 

in “understanding” the drawings. The Fog checkbox acts to dim the colors 

that are “further” away down the length of the kayak. The Fade Far Half 

checkbox will fade the colors on the side of the kayak that is away from the 

user. (This checkbox has no influence when the bow or stern are directly 

facing the viewer because there is no “away” side in this position.)  

For the purposes of this section, hull refers to the part of the kayak that is 

under water; side refers to the kayak between the waterline and the seam 

line. The deck or hull or sides can be “faded” to make them less conspicuous 
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and differentiate them from one another. Sometimes this is an alternative to 

simply turning off visualization of a given component. All these tools are 

applied independently to the edge or to the interior. 

A popup menu in the tab panel controls the overall color scheme. The 

options are as follows.  

1. Monocolor: This is the simplest. A single basic color is used for the 

Edges (or the Fill). You can select any color you desire by Shift-

clicking on the adjacent color square. 

2. Custom Colors: This allows selection of colors for each of six 

elements, the deck, hull and sides for the starboard and port side of the 

kayak. (Right and left sides of the boat from the perspective of the 

paddler). One useful shortcut is to click on the word Port to force the 

starboard colors to match the port colors or click on the word 

Starboard to force the port colors to match the starboard ones. 

3. Rainbow: Distributes most of the color spectrum along the length of 

the kayak helping differentiate the stern from the bow. 

4. Gradient: The user specifies TWO colors. The first determines the 

color of the bow and the second the color of the stern. The 

intermediate colors are blended. Appropriately chosen colors can help 

with the 3-D illusion. 

5. Grayscale: Distributes a grayscale along the length of the kayak to 

differentiate the bow from the stern 

The final set of checkboxes enable some miscellaneous functions. The 

waterline (Water Level) or the seam line (Seam Level) can be displayed on 

each of the individual cross-section. The seam line (Seam) can be drawn on 
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the kayak. Finally, a constant size (Size Constant) for the kayak can be set. 

As a default this option is not selected. The kayak grows or shrinks as 

necessary to “fit” within the window. This is generally desirable as it allows 

more detail to be shown. However, you can specify that the kayak not 

change size as it is rotated. 

Check out the discussion of SketchUp under the File: Output part of this 

manual. There are ways to visualize your design in 3D using third-party 

products. 

Visualize: Stability 

Evaluating the stability of a kayak is complex. Stability graphs provide 

only some of the information required to understand the stability of any 

given design. Many features of a kayak impact its ability to stay upright 

under difficult conditions of waves, wind and current. 

 The classic stability calculations make a number of simplifying 

assumptions. One assumption is that the center of gravity does not change 

relative to the structure of the boat as the boat heels. This holds true for most 

ships, but is not true of kayaks. The paddler represents much of the mass of a 

kayak, and that paddler will change position as the kayak tilts. Nonetheless, 

some useful information is provided. It has a great advantage of being 

objective rather than subjective. 

Exhaustive discussion of stability curves is beyond the scope of this 

manual. A good introduction to the topic is available on the web. 

www.guillemot-kayaks.com/Design/StabilityArticle.html 
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The basic principle is that as a vessel tilts, the center of buoyancy of the 

ship tends to move into a position lateral to the position of the center of 

gravity (mass) of the vessel. The upward force of the buoyancy and the 

downward force of the center of gravity are not exactly aligned which 

applies a torque to the ship that tends to return it to an even keel. Commonly, 

this situation will reverse at extreme angles of tilt. For many ships, the center 

of gravity will move lateral to the center of buoyancy, and there is no longer 

a righting force being applied. This will lead to a capsize. 

For kayaks, these calculations are made with the assumption that the 

paddler is sitting rigidly in the kayak. There are kayaks that are unstable at 

any degree of heel. To remain upright in such boats, the paddler shifts her 

body and uses the paddle to compensate for the tendency to capsize. For 

most recreational kayaks, there is a righting force applied when the kayak 

starts to tip. Commonly, however, with enough angulation the forces become 

directed toward further tipping rather than toward a return to an even keel. 

The stability curve plots the righting force in the Y direction over a range of 

angulation in the X direction. A classic stability curve tends to climb into 

positive territory as the kayak starts to tilt and then it reaches a peak and the 

righting force begins to decline. Finally, the line of the graph falls below the 

zero point and beyond this point it is the inclination of the kayak to capsize. 

The X axis is usually expressed in units of degrees. The Y axis is 

variously expressed in a wide variety of units. The shape of the curves is not 

affected. It is only when comparisons are being made that it is important the 

same convention for the Y units is being used. 

Bearboat Pro uses righting arms. Righting arms are expressed in units of 

distance, reflecting the distance from side to side between the center of mass 
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and the center of buoyancy. Bearboat Pro uses cm (GZ expressed in 

centimeters) as the default. Another common unit is the foot-pound. This is 

the unit used by Sea Kayaker magazine. The righting force is expressed as 

the distance in feet between the center of mass and center of buoyancy 

multiplied by the weight of the kayak in lbs. (righting moment). You can 

convert back and forth by multiplying the Y values by the appropriate 

constant. The shape of the curve is the same. The distinction is only 

important when comparing graphs. Make sure that the units match. 

 

On first entering the stability window, the program will compute the total 

volume of the kayak. When this calculation is complete, the result is 

displayed in the right upper corner of the window. This represents the entire 

volume both the underwater portion and the portion above water. One might 

consider this to be the total capacity of the kayak. This number is expressed 
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as a volume and a weight. The weight is just the weight of the kayak entirely 

filled with water. This may seem a peculiar way of expressing a volume, but 

displacements of boats are often expressed this way. You may think of this 

weight as being the weight that, when added to the kayak, would submerge 

it. This is NOT the design weight and should not be confused with it. 

Stability graphs depend upon the height of the center of gravity relative to 

the kayak. Stability graphs are in fact extremely "sensitive" to the exact 

height of the center of gravity. On first entering the stability window in 

Bearboat Pro, the center of gravity height defaults to 25 cm measured from 

the bottom of the kayak. The stability graph is also depends upon the 

displacement (weight) of the kayak and its contents. The stability window 

initially defaults to the design weight. Little arrows are provided to 

customize the height of the center of gravity and the test weight before 

creating a stability graph. When comparing one design to another it is 

important to try and keep these parameters the same. Slight changes in these 

parameters will often greatly affect the appearance of the stability graph. 

Changing the weight will change the waterline relative to the design 

waterline. As the kayak is made heavier, it will sink further down into the 

water. Tilting the kayak also tends to change the depth of the kayak in the 

water. This is tracked and calculated by Bearboat Pro. 

Interpretation of stability graphs between kayaks and from different 

sources is fraught with perils. One major source of difficulty is determining 

where the center of gravity should be considered to be. There is simply no 

way to come to a consensus on this. For example, when you consider a 

loaded kayak, should you consider that the weight is uniformly distributed 

through the volume of the boat or should you consider that the kayaker is 
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probably going to place the heavier objects lower in the boat. The kayaker 

represents the majority of the mass of the operating kayak. Where should the 

center of gravity of that mass be located? Some sources will correct for seat 

height. Is that fair? One brand might have an uncomfortably low seat, but 

that will make it look stable on the graphs even though everyone who 

actually buys the kayak finds that they have to put in some padding to 

elevate themselves a little. 

BearboatPro, by default, measures from the bottom of the boat. People 

have told me that there is a problem here because V shaped hulls will seem 

more stable than they actually are because the measurement is from the 

bottom of the V which is lower than where most of the mass (such as the 

paddler) can go. As a gesture to this concern, there is an option to measure 

the height of the center of gravity from a “seat”. This seat height is defined 

as the height above the bottom that a horizontal flat object 22 cm wide 

would find itself. Such an object could not be put all the way to the bottom 

of a V hull. I chose 22 cm because that is roughly the effective width of the 

human butt in this context. Obviously this is all a little arbitrary. The 

important thing is to think about the issue and be very attuned to how the 

center of gravity was determined when you read published materials. A 1 cm 

difference will have gross effects on the stability graph. 

Once the desired parameters are entered (you might just be happy with the 

defaults) click on the Create Stability Graph button. 

Generating the curve is computationally intensive and may take a minute 

or two. As the data is being calculated, the kayak is shown angling from the 

perpendicular (upright) position into a 90 degree tilt. The corresponding 

point on the stability graph is calculated and displayed. Once the stability 
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graph is complete, a slider will appear under the graph that allows 

positioning of a pointer anywhere along the graph. Your kayak design can be 

viewed at any degree of angulation. 

If the GZ is positive there is a force applied to try and right the kayak. If 

the GZ is a negative, the force applied is one to further the tendency to 

capsize.  

For most people, a stability graph in isolation is not of great value. Their 

usefulness is greatly enhanced by allowing a comparison of one kayak 

design with another. Since the shape of the stability graph is very sensitive 

to the parameters used (weight and height of center of gravity) it is important 

that these factors be held constant when comparing one design with another. 

Sea Kayaker magazine, for example, specifies the height of the center of 

gravity from the top of the seat. While there is some logic to this approach 

because the paddler will be sitting on that seat, it introduces a variable that 

can be confusing. Play with the stability calculations and see that the curves 

change a great deal with subtle changes in the height of the center of gravity. 

The program “remembers” the stability calculations that have been most 

recently performed. These can be called up by clicking on a checkbox 

labeled Prior. You can elect to show or not to show the individual prior 

graphs by clicking on the checkbox at the left of the list. Prior graphs can be 

deleted by selecting the line from the list and clicking on the X button at the 

upper left of the list. The description can also be customized. By default, just 

the name of the kayak is shown in that column. 

To facilitate comparisons further, there is a button labeled Create File. 

Bearboat Pro is limited in that it displays only a few stability graphs at a 

time. The Create File button serves a very important function. It will create 
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a text file that will end up in a folder called BearboatStable. A spreadsheet 

program, such as Excel, can open such a text file. In Excel, stability graphs 

can be created with the tools of the spreadsheet program. Data from several 

different “runs” of the Bearboat Pro stability calculations can be copied into 

a single Excel worksheet. The column labeled, GZ cm, contains the critical 

data. 

 Facility with programs such as Excel will allow the designer to compare 

the stability curves of any number of kayak designs under any number of 

conditions. Bearboat Pro even provides, in those text files, the conversion 

factors that are be required to convert the Y axis units from one standard to 

another. In this way, comparison with designs published in Sea Kayaker is 

possible. Care should be taken to read the fine print in Sea Kayaker to make 

sure that the height and weight parameters “match” as well as the Y units 

before interpreting these comparisons. The most useful comparisons are with 

previous designs of your own whose handling characteristics are very 

familiar. Old designs created in Bearboat Classic can be now analyzed after 

opening those designs in Bearboat Pro. 

Stability curves can vary considerably, and it may be necessary to adjust 

the Y axis range to accommodate this. There are little arrows positioned at 

the top and the bottom of the Y axis that allow you to make adjustments if 

the graph “runs off” the edge of the picture. 
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FILE 

File: Open  

Opens any previous kayak that was originally created in Bearboat Classic 

or Bearboat Pro. Bearboat Classic users have an opportunity to see their 

older designs with some of the new tools of Bearboat Pro.  

File: Save 

One can choose to save any kayak designed. Choose Save from the File 

menu and provides a name for the kayak. Kayaks that are saved in this 

fashion will end up in a folder called Bearboat Designs, which will be 

created in the folder that contains the application itself. This helps 

consolidate all the designs that a user might be working on. 

Kayaks CAN be saved as files compatible with Bearboat Classic. It is 

possible that some data will be lost, as certain features of Bearboat Pro do 

not exist in Classic. For example, some measurements can be specified to 

the nearest mm in Pro that can be specified only to the nearest cm in Classic. 

There is a place to enter a design note. This allows you to save more detail 

about your design than might be implicit in the name of the kayak. This note 

can contain anything. It just serves as a reminder to you about this particular 

design. If a kayak design has a note associated with it, that note can be 

viewed in the Particulars window (see Tool menu).  
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File: Output 

As was true of Bearboat Classic, the fundamental output of Bearboat Pro 

is the cross sections of the kayak being designed. To produce these cross 

sections, choose the Output option under the File menu. This portion of the 

program differs considerably from the equivalent area in Bearboat Classic.  

The initial task is to select exactly which cross sections to output. This is 

done in the group box entitled Specified Cross Sections, the use of which 

should be fairly self-explanatory. This group box contains a canvas that 

illustrates which cross-sections are presently selected for printing. At one 

extreme only a single cross-section can be specified. At the other extreme, 

every cross-section across the entire length of the boat at one centimeter 

intervals could be specified. The canvas shows the chosen cross-section on a 

graphic representation of the kayak, either the Birdview or the Sideview. 

Radio buttons allow changing back and forth between these two views. 

The next step is to go to the Print Cross-Sections group box and decide 

whether you want to have a skin depth drawn on your paper printouts. The 

printout below has included a skin depth of 1.5 cm, which is drawn as a red 

line deep to the surface of the cross-section. 
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Checking the Skin checkbox will force printing of a line on the cross-

sections that is a specified depth away from the surface. In the upper right 

part of the Output window there is a canvas that will show a picture of this 

concept if the skin option is selected. This is a very useful function of 

Bearboat Pro that was not available in Bearboat Classic. A skin of arbitrary 

thickness can be specified. One common building technique is to create 

several cross sections of a kayak being designed. These cross sections will 

be planked with some material perhaps cedar strips. Those strips themselves 

have a certain thickness. It is useful to be to have cross sections that are 

reduced somewhat from their true size to accommodate the thickness of the 

strips themselves. The skin checkbox allows the user to specify a particular 

thickness of the material that will be used in construction. When the paper 
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cross sections are produced by the program Bearboat Print, one will see a 

second line which will indicate the depth of the strip and allow one to simply 

cut out the cross sections at a slightly smaller size to accommodate the strips 

that will be used. 

Each sheet of paper has a line of text that describes the cross-section 

being drawn. The first piece of information is of the form A1 or B3. This is 

useful for cross-sections that require multiple pieces of paper to completely 

draw out. The letter (A) refers to the column. The number refers to the row. 

Therefore B3 refers to the piece of paper that would be taped into the second 

column of the third row. 

A1 B1 C1 

A2 B2 C2 

A3 B3 C3 

The second piece of information is the date and time that the 

BearboatPrint file was created. The third is the name of the kayak. The 

fourth is the position of the particular cross-section. The fifth is the scale to 

specifically indicate whether or not the graphic is life-size. Gridlines are 

provided to help align the cross-sections with one another and the individual 

pieces of the larger cross-sections with each other, There gridlines should be 

spaced at 2 cm intervals, and it would be wise to check this. If they are not at 

2 cm intervals, BearboatPrint is not communicating successfully with your 

particular printer. BearboatPrint has a tweaking function to slightly alter the 

output to try and adapt to your particular printer. If the gridlines are not at 2 

cm intervals, try using the tweak tool of BearboatPrint. 

Other less critical data is also supplied in that one line listing, and this is 
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fairly self-explanatory. The Skin width is documented. Generally, this 

should correspond to the width of the cedar strip if this is going to be a strip 

built boat. 

Next use the little arrows in the Scale group box to decide what size of 

printout to produce. Obviously, to actually create the kayak, you would want 

to have life-size paper printouts. However, in the design process, it can be 

useful to create smaller models of the kayak. The little arrows in the Scale 

group box allow specification of models of varying sizes, ranging from life-

size to 1/16th size. 

Once these preferences have been specified, push the Print File button. A 

message will shortly appear to tell that a file has been created. These files 

are called BearboatPrint files. They will automatically be placed in a folder 

called BearboatPrint. The name of the file will end with xsBBPF, which 

stands for BearBoat Print File (xs refers to cross-section). The file name will 

include the name of the design and the initial numbers will indicate when it 

was created (YYMMDDHHMM). For example, 

0209080536Excalibur_xsBBPF, is a file for a kayak that was called 

Excalibur produced on 09/08/02 at 05:36 in the morning. Note that the 

computer’s printer does not come to life. A separate program, BearboatPrint, 

is used to actually produce the printout. That program will import the data 

from a BBPF file and actually direct the printer to create the cross-sections. 

As a default that program will work with the standard paper size that most 

printers handle, 8.5" by 11". It is also possible to use 8.5” by 14” (legal 

paper). Cross-sections that are too big to be included on a single sheet of 

paper will be created on as many sheets of paper as necessary. The user 

tapes these sheets together to create the final form. 
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Another group box in the Output window is labeled Print Bow/Stern 

Profile. Many builders use profiles of the bow and the stern in their 

construction. The profile is just the middle of the kayak extending from bow 

to stern viewed from the side. Specify how long a profile you need (in 

general just a foot or two) and specify whether you want to print out a 

profile of the bow, the stern or both. The Print File button is pushed to 

create the file that can be used by BearboatPrint to print out on paper a full-

sized drawing of the profile. These files are another type of BearboatPrint 

files. They will automatically be placed in a folder called BearboatPrint. The 

name of the file will end with pfBBPF, which stands for BearBoat Print 

File(pf refers to profile). BearboatPrint will import the data from a pfBBPF 

file and direct the printer to create the profiles. 

There is another group box in the Output window with the label Grid 

Text Files. This is primarily for advanced users. Creating a file using the 

button in this group box will make a computer file that contains numbers 

specifying in centimeters the surface of the kayak at the chosen cross-

sections. This was referred to as Table of Offsets in Bearboat Classic 

The word Grid refers to the fact that this data is created in such a way that 

programs such as Excel can read this data and present it as data in a grid 

with rows and columns of data. Conventionally such data can be stored as a 

text file with each row of information demarcated by carriage returns. Each 

individual piece of data in a row is separated from the data in the next 

column by a delimiter. The program allows this delimiter to be a TAB or a 

comma. These are both popular conventions and Excel, for example, is 

capable of importing such data in either format. You can also at least look at 

these files in word processing programs such as Word or text editors such as 
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BBEdit. 

One reason to create these files is to move the data into other programs. I 

created the XYZ file as this file could be read, after a little manipulation, by 

a 3D computer-driven milling machine that was capable of carving out a 

plug for a mold. Other 3D visualization programs and CAD programs are 

capable of importing such data or at least a sophisticated user can transform 

this data into a form that can be imported. 

The XYZ refers to a convention of referring to a given point on the kayak. 

The surface of the kayak is described as points in space specified by their X, 

Y, Z coordinates. The Z coordinate identifies where along the length of the 

boat the cross-section lays. A point with a Z coordinate of 50 is on the cross-

section that is 50 cm from the bow. The X coordinate describes how far from 

the midline of the kayak that point lies. The midline of the boat has an X 

value of 0. The point that is at the widest place on the boat will have an X 

value of half the boat's width. The Y value is the distance of the point from 

the waterline. Negative values refer to points that lie underwater. Positive 

values refer to points that are above water. 

The data is provided for "half" the boat. Since kayaks are bilaterally 

symmetric, this essentially describes the entire boat. You may have to 

duplicate the data set with one of the parameters (X) made equal to the 

negative of its value in the new set for importation into some programs. 

Usually, this can be handled by the receiving program.. 

Bearboat Pro also has the capability of exporting your design as a DXF 

file. The created DXF file will be placed in a folder called BearboatDXF. 

DXF stands for Drawing eXchange Format , and was created by Autodesk to 

provide for a method of exchanging drawing file information in a generic 
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format. Autodesk is the developer of AutoCAD, which in one of the most 

popular computer aided design programs. AutoCAD can, of course, read 

DXF files, but this format has been widely adapted by other design and 

display programs as a method of importing and exporting graphic files. By 

converting your design into a DXF file, it can be imported for viewing or 

further manipulation in a large number of design programs. This is a one-

way street. Bearboat Pro cannot "read" DXF files produced by other 

programs.  

 

The above graphic is the result of using DXF to import a kayak design 

into a CAD program (in this case Cinema 4D for the Macintosh) and 

creating a rendering in that program. 

The DXF file created is a 3D file. It is a rather “minimal” file that can be 

read by many programs that purport to read DXF. Users and I have, 

however, run into problems. Some programs will not open the file. 

Sometimes this is because the program is a 2D program and these are 3D 

files. DXF has 2D and 3D versions and some programs only deal with 2D. 

There is a free program available for both Macintosh and PC that does a 

good job with handling the DXF files created by Bearboat. It is eDrawings 

Viewer and is available from SolidWorks. 

(http://www.solidworks.com/pages/products/edrawings/eDrawings.html) 
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This program nicely renders the design that you have exported as a DXF 

file. Remember to select the Both Sides checkbox so that you will see both 

sides of the kayak. Below is a kayak rendered in eDrawings. There is a 

simple toolbar that allows rotation and magnification of the model. 

 On the PC side there is a program called acmeCADSee that is a shareware 

program ($60). You can download a Demo to try it out. This program opens 

the file without difficulty and allows you to see the design from any point of 

view in 3D space. It also can save the design in a number of formats: 

AutoCAD 2000 dxf, AutoCAD R12 dxf, and AutoCAD R14 dxf. These are 
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all different “versions” of DXF. The files thus created are quite different 

when looked at with a text viewer (DXF files are simply ascii files).  

I mention this because I have found that sometimes a program that will 

not open a DXF file straight from Bearboat will be willing to open it after it 

has been converted by a program such as acmeCADSee into another 

“version” of DXF. Another program that I ran across, AutoVue SolidModel 

Professional Desktop, had a demo version that I could experiment with and 

it could open Bearboat DXF files and “Convert” them to other formats. If I 

chose DXF as the format, then I could open the resulting file in programs 

that had a problem with data fresh from Bearboat.  

Sometimes, the issue is related to the three-letter extension. On the PC 

side, try manually making sure the .dxf is the extension rather than .txt. 

There is a CAD program on the PC called Rhino that is a very sophisticated 

program for doing 3-D design. It is cheap for what it can do, but most people 

doing hobby kayak design would find it expensive. If you are interested in 

refining your design and specifying details such as hatches and cockpit rims, 

you should consider this program. It is also provides an entry point into 

CNC machining, in that many such machines will accept input from Rhino 

specified surfaces. Rhino will import DXF files, but will only  

“recognize” such files if the three-letter extension is .dxf. You have to 

specify in the Open dialogue box that you want to open a .dxf file and make 

sure the file from Bearboat has the .dxf extension. Rhino is available as free 

download demo that will allow you to visualize your design in any 

projection. It initially provides a wireframe view, but it will also allow you 

to see your Bearboat created design as a “shaded display” which is really 
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quite beautiful. Rhino will also open XYZ files. Manually make sure that the 

extension is .xyz.  

An exciting development as of May 2006 is the purchase, by Google, of a 

program called SketchUp that allows construction of 3D models. This 

program is excellent. There are high quality tutorials, and the program itself 

is quite approachable. Google has made the basic version of this program 

free on the Web. SketchUp is most commonly used to design architectural 

models and is not really suited for designing kayaks. However, it is a good 

visualization tool to look at your design in 3D. SketchUp is capable of 

examining (File: Import) the DXF file that Bearboat creates, and you can 

now look at your design and spin it around to your heart’s content. You can 

position yourself to view the boat as though you were the paddler or even 

look inside the kayak. It is best to create a DXF file with both sides of the 

kayak exported. After doing the import into SketchUp, it may seem that 

nothing has happened. Be sure to click on the “center object” button (third 

from the bottom on the left in the toolbar).  This will adjust the 

magnification factors and field of view so that the boat is visible. 

Unfortunately the free version cannot export the drawing in any formats 

other than SketchUp itself. SketchUp is available for both Macintosh and 

PC. The picture below shows a design as seen in SketchUp. 
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The DXF file describes the entire length of the boat. Any restrictions in 

the group box entitled Specified Cross Sections are not applied. The user 

can customize the DXF file in two ways. 

 First, there is a checkbox, Both Sides, that can specify that the output 

contain both sides of the kayak. By default only the right side of the kayak is 

sent. This makes the created files more compact. In general, the receiving 

program is capable of generating a mirror image and thus restoring the left 

side of the design if needed. However, if the user checks Both Sides then the 

resulting file will contain data for the left and right side of the kayak. 

Secondly, it is possible to adjust the size and detail of the created DXF 

file. The file contains the location in space of points on the surface of the 

kayak. Bearboat Pro could provide an infinite number of such points. The 
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goal is to provide only a "sensible" number of such points. The more points 

provided, the larger the file. The importing program may have difficulty 

opening a file with too many points, and you may have difficulty 

manipulating the design in that program if there are a huge number of points. 

Conversely, the fewer points provided the more of an "approximation" the 

file becomes. You can loose the detail of the design. There is a slider that 

allows the user to vary the number of points specified within a generous 

range to customize the file for different purposes and programs. Large files 

that contain a large number of points can take a little while to generate, so be 

patient. 
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BearboatPrint 
Using the BearboatPrint utility program is easy. The program’s only 

purpose is to take a Bearboat Print Files (BBPF) that have been created by 

Bearboat Pro and print out on paper the specified cross-sections or profile. 

The Bearboat Print Files that are produced by Bearboat Pro are sent to a 

folder called BearboatPrint that should be in the same folder as the 

application itself. (This folder is created if it is not already present)  

In BearboatPrint the user has two tasks. The first is to select the particular 

desired Bearboat Print File (BBPF) that has been created by Bearboat Pro. 

The second is to initiate printing out that appropriate file on paper after 

deciding whether to get a color printout or a plain black and white printout. 

BearboatPrint should create drawings of the appropriate size regardless of 

your printer. However, some users have reported to me that their printers are 

slightly “off”. This will be evident if the 2 cm grid that BearboatPrint places 

on the printout is not exactly 2 cm. There is a tweak parameter in 

BearboatPrint that can be adjusted to try and accommodate for this. If your 

grid is too small, you can increase the value of the tweak parameter from the 

default 100% to 101%, for example, if you find that your grids are 1% too 

small. 

The tweak checkbox exists to try and solve this very specific problem. I 

suspect that the fixable problem is relatively rare. The common household 

printer moves paper through rollers to allow printing from top to bottom and 

the common household print moves a print head to allow printing from side 
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to side. Printer drivers (the software that runs the specific printer) are 

supposed to tell the computer what command to use to move the paper a 

given distance and move the print head a given distance.  

I do not know what the tolerances are on a typical printer. It is possible 

that your printer might move its print head 1% more than it is supposed to. It 

is possible that the printer might move its paper 1% more than it is supposed 

to. Therefore when Bearboat Pro commands to draw a 2 cm square the 

square that is drawn is actually a little larger. If your printer makes the 

SAME percentage error, in both directions, then it is relatively easy to fix in 

software using the "tweak" function. Set the tweak value to 99% to 

compensate. The problem is that this assumes that your printer makes the 

same error in both directions. If your printer only makes its error in one 

direction, which would imply the squares that it draws are not perfect 

squares, then the tweak function will not work. 

Therefore the tweak function will only help people whose squares are still 

square but just a little larger or a little smaller than they should be. 

Many printers will accept legal sized paper, which is 8.5 by 14. If you 

have this paper available, BearboatPrint can take advantage of it to draw on 

larger sheets, which will reduce the number of sheets of paper required to 

draw the sections. I would like to offer the option to print on any size paper 

but I have not figured out how to do this. 

BearboatPrint is a PC only program. Mac users have to prevail upon a 

friend with a PC for this final step. I presume that Virtual PC running on a 

Macintosh would successfully run BearboatPrint although I have not tested 

this. BearboatPrint is a separate program that can be downloaded from 
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http://homepage.mac.com/rlivingston. 

Scott Pesci has informed of a service he offers to take the data from 

Bearboat files and create a PDF files that can be taken to any commercial 

printing house to print full sized sheets of each station. The user just sends 

the design file or the form xyz file. This could be useful for those you do not 

want to bother with taping multiple sheets of paper together or for Mac users 

who have no PC using friends (an elite group). For more information, go to 

his web site -- kayaktocad.com 
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More on Constraints (or Why the 
Red Lines?) 

The subject of constraints causes users more confusion than any other part 

of this program. Many users are confused by the fact that their designs are 

producing many cross-sections in “red”. The “red” is used to indicate a 

conflict in the chosen parameters. A further discussion of this topic follows. 

Consider any random cross-section on your design. There is a basic 

hexagon made up of six vertices that determine the shape of the cross-

section (FIGURE 1).  
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FIGURE 1 

 

1. There is a vertex in the midline at the top. The Sideview module 

determines the position of this vertex; it is the height of the peak of the deck.  

2. There are two vertices that define the seam lines. The Sideview module 

determines the height of these vertices; the Birdview module determines the 

horizontal distance between these two vertices.  

3. There are two vertices that define the waterline. The horizontal distance 

between these two vertices is determined by the Birdview module.  

4. The final vertex is in the midline at the bottom. The Sideview module 

determines its position; it is the depth of the kayak at that position. 
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Once these vertices are fixed, the program creates the curves that connect 

them and defines that particular cross-section. Above the waterline, this is 

fairly simple. The program allows the user to choose from a limited number 

of families of curves that determine the character of the curve that creates 

the deck and a limited number of curve families that determine the curve that 

creates the above water side of the kayak. 

The creation of the curve below the waterline is more complex. The 

program will draw the curve that will result in the minimum wetted surface 

and still conform to the constraints. This depends on one additional 

parameter that the user has specified in the Curve of Areas module, i.e. the 

cross-sectional area of that underwater section. It is possible that a conflict 

will occur among the three parameters that determine the underwater curve 

of the cross-section. Those three parameters are the depth of the underwater 

curve, the width of the waterline and the cross-sectional area. The most 

frequently encountered problem occurs when the cross-sectional area is 

greater than that which can be accommodated by the depth and the width of 

the waterline. The program indicates the problem by drawing the underwater 

cross-section in red. 

To illustrate these issues, consider the family of curves that would be 

created to accommodate progressively greater underwater areas if the ONLY 

constraint were a given waterline width and with the program trying to 

minimize the wetted surface. These curves seem reasonable as long as the 

cross-sectional area remains below a certain value. After this value is 

reached, the underwater sides start to blow out laterally. In FIGURE 2, you 

can see that the curve 5 and curve 6 are starting to bow laterally 
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FIGURE 2 

 

 

Now consider the family of curves that would be created to accommodate 

progressively greater underwater areas if there were TWO constraints, the 

waterline width and the depth. This is closer to the actual behavior of the 

program. Again these curves seem reasonable as long at the cross-sectional 

areas remain below a certain value. After this value is reached, the 

underwater curve starts bulging out laterally and down on each side of the 

midline. In FIGURE 3, you can see that curve 4 is bowing out laterally and 

inferiorly. 
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FIGURE 3 

 

The fact that the program does NOT show curves with these bulges 

reflects the fact that there is an additional “unstated” constraint on the 

minimum wetted surface curves. First, the depth of the boat can nowhere be 

greater than the depth of the boat in the midline. Secondly, the width of the 

underwater section can nowhere be greater than the width of the boat at the 

waterline. So really, the family of underwater curves is constrained by a 

rectangle whose width is the waterline width and whose depth is the midline 

depth of the boat (FIGURE 4). 

 

FIGURE 4 
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With the curves constrained by this rectangle, a problem occurs when the 

specified cross-sectional area is greater than the area of this rectangle. The 

designer is responsible for adjusting the relevant parameters so that this does 

not happen. The program alerts the user to this problem by drawing the 

cross-section in red and by appending triangles to each side of the rectangle 

to create a cross-sectional areas as great as that demanded by the curve of 

areas. This is illustrated by curve 5 of FIGURE 4. The size of these 

appended triangles gives the user a visual cue of how far off he is. To “cure” 

the situation, one can increase the depth or increase the waterline width or 

decrease the cross-sectional area or some combination of the above. 

This is relatively straightforward. But the situation becomes more 

confusing when the user specifies additional constraints, particularly the 

water angle and the keel angle. By placing these additional constraints, the 

likelihood of a conflict greatly increases. The area in which the underwater 

curve is created is now more confined (FIGURE 5). Users may find that 

many of their cross-sectional drawings are plagued with red. It has become 

easier to specify at any given location a cross-sectional area that is larger 

than that possible within the other constraints. 

 

FIGURE 5 
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As a practical matter, it is wise to design your craft first with NO 

additional constraints. Once the kayak has been roughly specified, start 

judiciously applying the additional constraints. If you want a keel angle of 

75 degrees, do not apply that value at first. Try a value like 85 degrees and 

then review your cross-sections to see if things are still OK. Then try 80 

degrees. By working your way down towards the goal of 75 degrees in steps, 

reviewing the cross-sections at each step, it is much easier to understand the 

conflicts that may arise. Do not change the water angle and the keel angle at 

the same time. Make a change in only ONE constraint and see its affect on 

all the cross-sections before changing the other one. This cautious technique 

will allow you, the designer, a much better understanding of what is 

happening than would be the case if you radically changed the water angle 

and the keel angle. If you do the latter, you may go back to the cross-

sections and just see them all “having problems” i.e. all drawn in red. 

Applying a marked water angle can create another conflict that will be 

indicated by the underwater cross-section being drawn in purple. If the boat 

at a given cross-section is relatively deep and narrow then a given water 

angle may be too severe and prevent the underwater section from getting to 

the required depth. The program will draw a cross-section in this 

circumstance that breaks out of the confines of the water angle. It is easy to 

simply ignore this “problem”. The underwater cross-sections will be 

reasonable. They are drawn in purple just to bring the situation to your 

attention. This circumstance is relatively rare. 

As was pointed out elsewhere, minor problems at the very ends of the 

boat are not really all that important. Where the underwater area is very 
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small and the depth is shallow and the width is narrow, it is easier for 

conflicts to occur. In this location, they are not very important as they are 

easily “sanded out” in the real world. 

To summarize, if you are having a problem with understanding why some 

of your cross-sections are drawn in red, start removing or lessening any 

constraints that are present. By loosening these constraints, the red cross-

sections will disappear. Then start reapplying the constraints in a graduated 

fashion, checking the cross-sections at every step. This will allow you to 

understand the problem and where and why it is occurring. If you do not 

have any special constraints applied and are still having problems, try 

considerably increasing the depth of the boat. This will make the red cross-

sections go away. Then start gradually reducing the depth of the boat 

reviewing the cross-sections at every step. This process should make things 

clearer. Even as the designer of this program, I occasionally find myself 

confused as to exactly why a cross-section is violating its parameters. The 

technique outlined above always clarifies the situation. 
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TUTORIALS 

Tutorial #1 (Long Narrow Kayak) 

To familiarize you with the program, this tutorial will go through the 

process of designing a long narrow kayak intended for day paddling.  

1. Go to the Tool menu and select Restore Generic Kayak Defaults. This 

will restore the values in the program that were in place when the 

program first opened. 

2. Go to the Design menu and select Curve of Areas. (actually you are 

probably already there at this point. Now you will see a graphic of the 

underwater area of the boat plotted as a function of the position on the 

boat. 

3. We want a kayak about 18 feet long. Go to the Length data entry box and 

enter 550. Hit the TAB key to have the value that you have entered 

register. This is 550 centimeters, which is 18’ 1” long. 

4. We want a long swept up bow so lets make the point of entry into the 

water 40 cm from the bow itself. Type 40 in the Enter data entry box and 

hit the TAB key to have the value inserted. You will notice that as you 

make changes the graphic will add them to the preexisting drawing. To 

refresh the drawing and erase all the old data, click on the Refresh button 

or hit the space bar on the keyboard. Do this whenever the graphic is 

looking cluttered. 
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5. We want the end of the underwater portion of the boat to be close to the 

stern. Place 545 in the Exit data entry box. This is just 5 cm from the end. 

6. Let’s change the curve of areas slightly. Perhaps we want the prismatic 

coefficient of the bow portion to be a little greater. Enter 30 in the Bow 

data entry box (to replace the 26 that is currently there). Note that the 

curve of areas changes slightly. Let’s make the stern prismatic coefficient 

a little less. Look at the MidStern data entry box. Use the adjacent little 

arrows buttons to adjust the value from 86 to 80. This method is in 

general “easier” than actually typing in the new value, but the effect is 

the same. 

7. The Displacement now reads 130 kg but this is more than we want for 

this boat. If we weigh 78 kg (170 lbs) and anticipate the boat will weigh 

18 kg (40 lbs) and are going to be using it on day trips and taking about 9 

kg (20 lbs) of equipment (paddle, safety equipment, food etc), we would 

like the design displacement to be 105 kg (230 lbs). Enter 105 in the 

Displacement data entry box and see how the value for the Max Cross-

Sec Area changes. For now we are through with the curve of areas. Lets 

go to Birdview area to get a look at the kayak as viewed from above. 

Choose Birdview from the Design menu. 

8. The seam line of the boat is presented in black. Within this, the waterline 

is visible in blue. We are trying to make a long skinny boat so lets change 

the Maximum Seam Width to 54. This will make the width of the boat just 

over 21”. Lets make the Maximum Water Width 51 cm. This will make 

the width of the boat at the waterline a little over 20 inches. To make the 

waterline bow a little finer, make the MidBow parameter a little less 
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(change the 145 to 135). This change affects the shape of the boat to the 

greatest degree in the region of the Bow side of the mid boat.  

9. Lets make the seam line of the boat a little wider at the stern than it 

currently is. Change the Stern parameter to 75 from 55. Note the bird’s 

eye view of the seam line shows it wider toward the stern than it was 

before. By changing the various parameters you can create a wide variety 

of shapes. 

10. Let’s say you have decided to place the seat 20 cm behind the center of 

buoyancy. You can click on the pinkish color square next to the Center of 

Buoyancy to have an indicator line placed on the kayak drawing. To 

show where you are planning your seat, type 325 (20+305) into the 

location line data entry box and make sure that Show Location Line is 

checked. This will allow you to visualize where your seat is going. Note 

that the values of the width, depth etc. of the boat at that position (325) 

are provided. That cross-section is shown in the canvas at the lower right. 

The nearby slider can be used to “move” the location line up and down 

the boat.  

11. Now we will take a view of the boat from the side. Choose Sideview 

from the Design menu. Looking at it, we decide that we want 50 cm of 

bow overhang instead of the 40 cm that we entered earlier. Change Enter 

to 50. There are several parameters such as this that can be changed in 

multiple locations. Be careful, as some of these changes will affect other 

parameters such as the center of buoyancy. Indeed, moving the Enter 

point has slightly pushed back the center of buoyancy. 
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12. The side profile of the deck is entered manually by providing values in 

the Add Deck Specification group box. First, delete at the default 

specifications. Click on each one of them (to highlight them) and then 

push the Delete button. At the bow and stern, we want to the deck to be 

above the seam line where it sits by default. In the Location data entry 

box enter 1 and in the Height data entry box 35, which is 2 cm above the 

seam line at the bow. Then click the Add button. Next Enter 549 in the 

position box and 20 in the height box, which is 2 cm above the stern 

seam line. Again click on the Add button. Lets say that we want the deck 

a little lower where we are sitting which we decided would be at position 

325. In the Location data entry box enter 325 and in the Height data entry 

box 18. If we want a little more storage room behind the paddler, we 

might enter at position 330 a height of 24. If the transitions seem too 

abrupt, they can be smoothed with the slider underneath. Moving the 

slider toward Flat creates gentler curves in the profile. Let’s move it to 8. 

13. We have changed the parameters considerably. Go back to the File menu 

and chose Save As… This will bring up the Save window. Enter 

TutorialBoat as the name of the kayak. This will preserve a copy of this 

boat on the hard disk. It can be accessed in the future by choosing the 

menu item Open under the File menu and finding “TutorialBoat”. By 

default all your design are placed in a folder called BearboatDesigns, 

which should be in the same folder with the application. If this folder 

does not already exist, it is created automatically. 

14. Now take a look at the cross-sections that we have specified. Choose 

Cross-Section from the Design menu. Move the Location slider at the 

bottom of the page to see the boat at various stations along its length. The 
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underwater portion of the cross-section is rather angular. Remember that 

this program is creating the minimum wetted surface at each position 

within the constraints that have been imposed. The depth of the boat (14 

cm) is probably too great. Go back to the Sideview area (Sideview in the 

Design menu. Try changing the waterline to 10 cm.. Go back to Cross-

Section. Notice that there is now a more rounded hull shape. 

15. Go to position 60 (near where the boat is entering the water). You will 

see that the underwater shape is “peculiar” and it is displayed in red. The 

reason is that here there is conflict among the various parameters. The 

program has been asked to put an underwater area here that is GREATER 

than a rectangle with a side-to-side dimension of waterline width and a 

height dimension equal to the waterline. Therefore, the underwater area 

has to expand out beyond the confines of a simple rectangle. When this is 

seen at the extreme ends of the boat it is not of much consequence. At the 

time of building the plug, the “extra” will be sanded off. You can largely 

get rid of these “problem” areas by readjusting the parameters. (Some 

combination of widening the waterline at this position, increasing the 

draft of the boat, increasing the depth of the boat at this position, 

decreasing the cross-sectional area at this point etc. could be used) 

16. One approach is to increase the waterline width at the bow. Return to the 

bird’s eye view. Choose Birdview from the Design menu Let’s increase 

the fullness of the bow by changing the bow parameter from 35 to 55. 

Return to the cross-section views to see that this has, for all intents and 

purposes, gotten rid of the peculiar red areas. 

17. Look at position 370. Some might see the bottom as too flat. This can be 

prevented. Choose Constrain Cross-Section from the Tool menu. Set 



 82 

the Maximum Keel angle to 85. Then return to the Cross-Section window 

by choosing Cross-Section from the Design menu. You can see that 

this constraint prevents a completely flat bottom to the kayak. 

18. Choose Output from the File menu. In the Specified Cross-Sections 

group box in the upper left, specify which cross-sections that you want to 

print out. For now, to save paper, just chose one cross-section. Choose a 

1/5 size using the little arrows in the Print Cross Sections group box and 

then click on the Print File. You will create a computer file that will 

include the name BBPF. This will be deposited on your hard disk in a 

folder called Bearboat Print. At any time, you can take this file and open 

it using the utility program BearboatPrint to actually create a paper 

printout. 

19. If this were a real design, you would want to choose Save As… under 

the File menu so that all your changes would be saved to disk under the 

name TutorialBoat or whatever you have named your craft. 

Tutorial # 2 (Short Fat Kayak) 

For this tutorial we will try designing a modified Keeowee kayak. The 

Keeowee is a short plastic rubber-ducky type of kayak that in fact is a very 

useful craft. We are going to pretend to build a cedar strip version. This is 

not the sort of kayak that one would generally associate with a beautiful 

sleek cedar stripped "boat", but that is not the point here. We are going to 

have some fun and use this as an example of how you might decide to go 

about designing a kayak.  

The first thing to do is to get some rough measurements from the craft at 

hand. This is going to be our prototype. With the aid of a measuring tape I 
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went out and quickly obtained about it five measurements off of the 

Keeowee that I own and will now go ahead and to roughly model the kayak 

in the program.  

 

Length: 9’ 2” 

Width: 30” 

Width: 20” from the bow is 17” 

Width 20” from the stern is 20” 

Height of the Deck: about 12” above the GROUND.  

(Remember that measurements in Bearboat are all made from the 

waterline. I did not want to get wet so I didn’t get THAT measurement.) 

As an American, I got these measurements all in Imperial Units since that 

is the tape measure that I grabbed. Remember that the measurements in 

Bearboat Pro are in centimeters so we will have to do some conversion. 

Start with creating a curve of areas. Curve of Areas is the window that 

will open when you first start the program. I recommend that designs be 

started here. When the program starts, you are looking at a random example 

Generic kayak. This is where we will start the tutorial. We will mold this 

into a Keeowee. If you are not already looking at the Curve of Areas 

window, go to the Design menu and choose the menu item Curve of 

Areas. 
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Some find this approach rather abstract; they are eager to start “drawing” 

their boat not fooling with some graph. Try to think of designing a kayak in 

Bearboat Pro as a process of “molding”. The decisions made in the Curve of 

Areas window are very basic and rather easy. The process is akin to 

grabbing a certain amount of clay if you were planning to mold something. 

The curve of areas determines how much “clay” is going into the underwater 

part of your boat and how that “clay” is going to be distributed from bow to 

stern. Once this mass of clay has been determined, the further processes in 

Bearboat “mold” that clay rather than “carve” it. As you choose other 

parameters, such as the waterline width or the depth of the boat or the keel 

angle, you are pushing and pulling on the clay to mold it. You are not 

carving it away or adding to it. If you push here by constricting the waterline 

the clay will expand down. If you pull the clay down, by increasing the 

depth the underwater “sides” of the clay will get drawn in. The only way to 

“add more clay” or “remove some clay” is to come back to the Curve of 

Areas window and modify the graph here. 

The advantage of this approach is that by determining the curve of areas 

you are basically determining all the basic hydrostatic characteristics of the 

kayak. The prismatic coefficient and the underwater length and the center of 

buoyancy are all determined by deciding the curve of areas. These are the 

basic factors that determine how smoothly your boat will move through the 

water. With the curve of areas “fixed” as the initial step, as you set the other 

parameters of your kayak your design retains its basic hydrostatic 

characteristics. It also forces you to be “honest”. You cannot just demand 

that this cross-section be rectangular with a certain width at this given point 

if the curve of areas does not permit because you do not have enough “clay” 
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here to create that particular shape. Yes, you can always go back to the 

Curve of Areas window to add a little more clay here or take some clay 

away there, but the program forces you to maintain a “smooth” curve of 

areas. If you add some clay to a certain location to get the rectangular cross-

section that you think you want, then the adjacent cross-sections are going to 

be affected. 

It gives me peace of mind to know that the curve of areas is acting like a 

sheriff and enforcing sensible rules as I go out to design the other features of 

the kayak. I can be as “radical” as I want with other parts of the kayak and I 

know that the curve of areas is forcing a reasonable hydrostatic behavior of 

the kayak. My kayaks are, in fact, quite radical, but I am not trying to rewrite 

the laws of physics. Lots of research has gone into describing the hydrostatic 

resistance of shapes characterized by their length and prismatic coefficients. 

So here we are in the Curve of Areas window. The Keeowee kayak 

measures about 9 ft. 2 in. (about 347 centimeters) so enter 347 in the Length 

data entry box. **--It has been brought to my attention that 347 centimeters 

is NOT 9 ft. 2 in. Instead it is 11’ 5”. But to follow along with this tutorial, 

enter 347 centimeters ANYWAY and you will be able to match what follows. 

I will correct this in the next version of the manual. --**. The bow of the 

Keeowee plunges down fairly vertically to the waterline so in the Enter data 

entry box we will enter 5. Similarly the stern of the kayak comes down fairly 

steeply toward the waterline so we will enter a 343 (just short of the stern) in 

the Leave data entry box. The Enter and Leave points define the beginning 

and end of the underwater part of the kayak. Now I do not know exactly 

where the maximum underwater cross-section is for the Keeowee kayak, but 

it somewhere near the middle and I would suspect that it is a little more than 
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half a length of the kayak so we will enter, in the Location of Max Area, 180 

cm. After you enter the 180, you can hit the TAB key to insert this value into 

the program.  

If you've been watching the main canvas as we enter these numbers you 

will see an accumulating scramble of graphic lines appearing with a new one 

being drawn every time we change one of these parameters. To clean up the 

graphic you have a choice of clicking on the Refresh button (which is at the 

at the bottom right of the canvas) or simply tapping on the spacebar of your 

keyboard. We will go ahead and click on the Refresh button. 

 

Now I am sort of curious whether my Location of Max Area is indeed a 

little more than halfway along the length. Perhaps I made a math error. 

There is a button labeled Straight Lines that will draw some reference lines 

on the canvas. One of those lines is the midpoint of the underwater area of 

the kayak. Click on the Straight Lines button to see these lines. To see 

location of the maximum area, click on the green color square that is near 

the Location of Max Area label. Clicking on that square will display on the 

graphic a green line indicating the site of the location of maximum area. One 
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can see that, in fact, the location of maximum area is a little closer to the 

stern than the true midline of the underwater part portion of the kayak.  

 

Take time at this point to notice that the main canvas is labeled at the top 

with the word Bow to the left and the word Stern to the right. This indicates 

the default convention in Bearboat which is to show the images of the kayak 

with the Bow to the left and Stern to the right. Many nautical design 

programs use the opposite convention; the bow is to the right. I hope to 

make this a user configurable parameter at some time, but this is not 

implemented now and in Bearboat the Bow is to the left.  

Now decide what the design displacement for this kayak will be. Pretend 

that you are a stocky fellow who, dressed for kayaking, weighs 221 lbs. The 

Keeowee is not intended for prolonged trips so we would not be carrying 

much more than the weight of the kayak, the paddle and perhaps some lunch 

for a total of about 50 additional pounds. Therefore choose a design 

displacement of a 123 kg. corresponding to a design weight of 271 lbs.  

Notice that when changing the displacement the graphic does not change 

in appearance. The main canvas is simply showing the shape of the curve of 

areas with the maximum underwater area always plotted at the top of the 

graphic and the side-to-side dimension of the graphic simply representing 

the length of the kayak. Changing the displacement changes the Maximum 
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Area as you can see if you watch that parameter. In Bearboat Pro, as a 

preference, you can change the Maximum Area instead of the displacement. 

This was how Bearboat Classic was set up. However, it is a lot easier to treat 

the displacement as the primary parameter. I owe this insight to Ross Leidy 

who is writing his own kayak design software, Kayak Foundry, which will 

be worth checking out when it becomes available. 

On the right-hand side of the window there is a group box labeled 

Superimpose. Superimpose a side view of the kayak that we are designing 

by clicking on the Sideview button. At this point, our design is a peculiar 

amalgam of the Generic kayak that we started with and the Keeowee.  

A short, stubby, hop-in kayak of this sort should be designed to be quite 

stable. The prismatic coefficient is now .544. We are going to increase it a 

little bit. You can see that Bearboat shows the bow and stern prismatic 

coefficients as well as the “total” prismatic coefficient. This parameter, 

which you will see a lot of in nautical design books, is totally determined by 

the shape of the curve of areas.  

 

Let's increase the prismatic coefficient by making the curve of areas of 

little blunter toward the bow. In the Shape Curve group box, click on the up 

little arrow to increase the Bow parameter from 26 to 28 and the Mid-Bow 

parameter from 91 to 95. You will see that the prismatic coefficient of the 

bow half of the kayak increases and the prismatic coefficient as a whole is 
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now 0.558. These values are shown in a group box in the lower left half of 

the window called Prismatic Coefficient.  

 

We have now specified the curve of areas that we want for the kayak 

we're designing. Next we will proceed to an overhead view of the kayak to 

enter a few more of the measurements that we obtained from our Keeowee 

prototype. First, however, let’s save the work that we have already done. 

This is particularly important in beta software. Save frequently.  

Go to the File menu and chose the menu item Save. This will bring up a 

window that allows naming the kayak. We will use the name Kiwi for our 

design. Also check the option Date/Time Stamp. This will allow us to have 

multiple saved copies of the Kiwi, each distinguished by a unique name 

depending on exactly when the Save occurred. Once you have checked that 

checkbox and typed in Kiwi, just click on the Save button. Your design as it 

currently stands, will be saved in a folder that sits in the same folder as your 

application. That folder will be called BearboatDesigns. It will be created 

automatically and is a good place just to keep all the designs that you want 

to work with. At any later time, you can return to this point in your work. 
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Just go to the Open menu item under the File menu, and open any old 

design. 

Once we have saved our work for safety’s sake (so we don’t loose it in a 

computer crash) go to the Design menu and choose Birdview. Here the 

parameters that affect the overhead view of the kayak are chosen. This might 

equally have been called Fishview because we are equally going to be 

choosing parameters of the kayak as viewed from below. 

At this point the main canvas shows a rather peculiar shape reflecting the 

default “generic” parameters that we started with being modified by changes 

in the length of the boat. There are two lines, one indicating the profile of the 

seam line of the boat and the other representing the profile of the design 

waterline of the boat as seen from above (or below). One of the reasons that 

the picture looks so peculiar is that the widest point of the waterline and the 

widest point of the seam line are currently near the stern. 

Correct that now. Make the Location Maximum Seam Width near the 

middle of this kayak say 195 cm. Make the Location Maximum Water Width 

with the 185 cm. Cleanup the multiplicity of lines by clicking on the 

Refresh button. Now enter the maximum width of the Keeowee, which we 

measured at 30 in. One way to enter this value is by clicking on the little 

arrows seen to the right of the Maximum Seam Width data entry box. Doing 

this changes the width of the boat very subtly, actually only a millimeter at 

time. It might be a little tedious clicking enough times to reach the desired 

30-inch width. In BearboatPro, by clicking on the up arrow while holding 

down the Shift key, the changes can be made to work more rapidly (here a 

cm at a time) and by doing this we can make the Maximum Seam Width of 

the kayak 76 cm which is close to 30 in. The Maximum Waterline Width will 
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have to be slightly less than this. On looking at the Keeowee, there is 

relatively little overhang of the seamline over the waterline (the sides of the 

kayak are close to a vertical) so we will make the Maximum Waterline Width 

74 cm  

When I measured off of the Keeowee, the width of the kayak, 20 in. from 

the bow, was 17 inches. To see the corresponding measurement for our 

design, use the Show Location Line tools. There is a checkbox called Show 

Location Line. Select that option. A specific location will now be indicated 

on the graphic by vertical yellow line. Use the slider to move that line to a 

point about 20 inches from the bow of the boat (position of approximately 

51 cm.) The seam width here is being shown as 19.2 inches, which is fairly 

close. To decrease this to 17, go to the controls in the Shape Seam group 

box. These controls refine the curve of the seam line. Since the location line 

is closer to the bow than the mid point, choose the Bow parameter. Use the 

little arrows to decrease that parameter to 39, which will make the seam 

width at the chosen location 17 inches (or 43.2 cm). Now I also measured 

the Keeowee as being 20 inches wide at a point 20 inches from the stern. Use 

the location line slider (and the little arrows to make small changes) to move 

the location line to 295 cm, which is about 20 inches from the stern. The 

current width here of 16.8 inches is less than what we want so go to the 

Stern control in the Shape Seam group box and increase that parameter 

from 55 to 79 to make the width at this position 20 inches. 

Looking at the graphic, there is a fair amount of overhang of the seam line 

over the waterline at the bow and stern. The Keeowee has fairly vertical 

sides. Go to the controls that operate on the waterline curve (Shape 
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Waterline) and change them so that the waterline curve is closer to the seam 

curve.  

Shape Waterline 

Bow  43 

Mid-Bow  145 

Mid-Stern  94 

Stern  75 

For now we are done with the Birdview parameters. In the course of 

actually designing a kayak, you will find yourself going back and forth 

between the various design windows. For now we will go on to the Sideview 

and recreate the look of the Keeowee kayak from the side. For safety’s sake, 

you might want to go to the File menu first and Save the work that we have 

done so far. Choose the Date/Time Stamp option first so that the file will be 

labeled with the time that you saved it. 

Go to the Design menu and choose the menu item Sideview. The first 

thing we will do is get rid of all the deck specifications which are left over 

from the default kayak and which are creating the peculiar lumps of the deck 

profile on the main canvas. By clicking on the individual locations and 

height values they will be moved up into the Edit Existing Deck 

Specification group box where they can be deleted. Delete them all, one by 

one. 

Measuring the Keeowee showed that the deck line was about 12 inches 

above the GROUND for the entire length of the kayak. We will estimate that 

to be about 8 inches over the waterline. 8” is about 20 cm so enter 20 in the 
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Bow Seam Height data entry box and in the Stern Seam Height data entry 

box. 

Add two deck specifications.  

Location 1 Height 22 

Location 346 Height 22 

This will create a deck that is a little higher than the seam line, which 

Bearboat will insist on anyway. 

To make the seam line drop down to a low point near the midline, enter 

170 for Location Lowest Seam. 

The underwater side profile of the kayak is quite different from the 

Keeowee because as it sits now the deepest point is very close to the stern 

whereas with the Keeowee itself the deepest point is fairly close to the 

midline. Make the Location Deepest Draft 200 cm.  

The shape of the rocker of the Keeowee is a lot is more symmetric than 

what is shown on this graphic so in the Shape Rocker group box, we will 

decrease the stern parameter to 100 and increase the bow parameter to 80 to 

make the rocker more symmetrical and closer to the Keeowee kayak. You 

can simply directly type in the 80 and 100 values or use the little arrows. 

Make sure that the Show Location Line checkbox is selected. Now grab 

the location line slider and move it back-and-forth along the length of the 

kayak. You can see in the canvas at the right lower corner of the window, 

the shape of the cross sections. You will see a much more angular contour to 

the cross-sections then actually exists in the Keeowee kayak which has a 

nearly flat bottom. To correct this we will change the draft of the kayak. 

This is what I mean by “molding” the design as thought the underwater 
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section were clay. Take the slider and move it to do about the 200. Hold the 

Shift key down and click the down little arrow near the Draft data entry box 

to reduce the draft to 10 cm which creates a pattern, at least in the middle of 

the boat, of a rather flat bottom kayak such as the Keeowee. 

To superimpose an overhead view of the kayak, click on the Birdview 

button in the Superimpose group box. To superimpose a vertical line 

corresponding to the Center of Lateral Area, click on a little green colored 

square to the left of that label. What if you do not like the color green? You 

can change the color of that line, and indeed any of the other color squares 

used in this program, by holding down the Shift key and clicking on the 

particular color square. This will bring up a color-selecting tool that will 

allow choosing an alternative color, say the color red. This will now show 

the Center of Lateral Area as a vertical red line on the graphic.  

Now move on to the cross-section design window. Go to the Design 

menu and choose the Cross-Section menu item. This window is largely for 

visualization. The only to changes that can be made to the kayak are to 

change the profile contour families for the deck and for the side. In the Side 

group box, go ahead and choose from the pop-up there the Straight option. 

This will make the sides of the kayak straighter than the Bezier default. The 

Angular/Smooth slider that appears refers to the junction between the 

waterline and the side. That junction can be made smoother or more angular 

depending on the choice of this parameter. After looking at the straight 

family and moving the Location Cross-Section slider at the bottom of the 

page we might decide that we actually preferred the default Bezier curves so 

return to that choice by choosing Bezier from the Side pop-up. 
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There are similar options for the deck profile in the pop-up that sits in the 

Deck group box (Semi-Ellipse, Arch and Bezier). The semi-ellipse is a 

good approximation of what we need for the Keeowee kayak but for 

curiosity's sake you can check out the appearance of the Arch and the 

Bezier alternatives. As on the other design windows, there is a Refresh 

button on this page, which will clean up the graphic after you are finished 

experimenting.  

To visualize your design in your own head, it is useful to use the 

Location Cross-Section slider at the bottom of the page to move back and 

forth through the kayak. Make sure that the Show Location Cross-Section 

checkbox is checked. A reference line will move back and forth on the 

reference image as the viewed cross-section changes in the main canvas. As 

a default, the reference graphic is an overhead view, but you can substitute a 

view from the side by clicking on the Sideview radio button. 

It is possible to view multiple cross-sections of the design simultaneously. 

The Multiple Sections group box contains the controls that permit this. 

Basically, choose a Start location and an End location and an Interval value 

to determine how many intervening cross-sections to draw. As an example, 

enter 5 for a Start value and 100 for an End value and 5 for an Interval 

value. Then click on the Clear/Draw button. The specified cross-sections 

will appear. To avoid seeing the yellow location cross-section unclick the 

Show Location Cross-Section checkbox and click on the Clear/Draw 

button again. 

There are a number of different ways that these cross-sections can be 

viewed. Try unselecting the Side checkbox that sits in the Multiple Sections 

group box. Click on the Clear/Draw button. Now you will see the cross-
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sections with the sides omitted to help differentiate the components. 

Currently, you are seeing the sections the single color that is indicated in 

color square near the Monocolor checkbox. Select the Side checkbox again 

unselect the Monocolor checkbox. Now the various parts of the cross-

sections are shown in different colors. 

Alternative looks are offered in the Transparent pop-up. Choose Fog: 

Bow and click on the Clear/Draw button to see the sections as though 

looking from the bow end into a fog. Play with the other options to get a feel 

for how they look. 

 

Looking from the bow Fog: Bow 

 

Also try the settings in the Deck & Hull pop-up and the Bilateral pop-up. 

These allow you to see more restricted views of the kayak in greater detail. 
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Contour and Unilateral and Underwater Only 

Return now for a look at roughly the center of the kayak. Make sure that 

Show Location Cross-Section checkbox is checked. Move the slider back 

to the center of the slider area or perhaps more simply just click on the 

reference canvas at the place where you want to see the cross-section. 

Instantly the location line will move to the point where one where you 

clicked, and you will see this cross-section in the main canvas. The Keeowee 

has a flat bottom, but it is not this flat.  

It might appear that you do not have control over the cross sectional shape 

of the underwater area in BearboatPro but that is not really the case. You do 

not have DIRECT control but you can still “mold” it. The program is always 

striving to create a cross-section with the minimal wetted surface within the 

restrictions of the waterline width and the depth. The curve of area 

determines what the cross sectional area at that particular point on the kayak 

is. The curve of areas determines how much “clay” is present here. 

Changing the width or depth will change the shape of a given underwater 
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cross-section. There are, however, additional ways that the designer can 

constrain the underwater cross-sections. One of the functions these 

additional constraints serve is to prevent the completely flat bottom kayak. 

While it might have a minimized of wetted surface, it can carry with it some 

unrelated disadvantages. Specifically, it is a shape that is not conducive to 

creating a stiff form in many materials. Also, designers frequently want 

some kind of defined keel line because they feel it improves tracking. 

Go to the Tool menu and select the menu item Constrain Cross-

Section. The tool we are interested in now is adjustment of the Maximum 

Keel Ankle. The keel angle of 90 degrees allows a completely flat hull. There 

is a smaller canvas underneath the main canvas that allows you to specify 

where on the kayak you would like to look as you change the keel angle. 

Take the slider and choose a location value of about 160, which will show a 

cross-section of the kayak near its midline. Now change the Maximum Keel 

Angle to 86 degrees. At this point you will see that the kayak cross-section 

overlaps the darker blue area, which indicates the region now forbidden by 

the recruitment of this additional constraint. To see the effect on your kayak 

design, click on the button called Apply New Constraints. Now the bottom 

of the kayak is adjusted so that it conforms to the restricted space now 

available with the application of this additional constraint. Slide the slider 

bar back and forth to see the effect of this constraint on the entire length.  

You will probably notice a problem. At the position 180 and thereabouts 

the cross-section is drawn in red. This means that the computer has detected 

a violation of logic, a conflict. At this cross-section, you have restricted the 

area available by changing the maximum keel angle so a degree that the area 
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specified by the curve of areas does not fit. You can cure this by doing or 

more of several things. 

1. Back off on the Maximum Keel Angle Specification 

2. Change the curve of areas so there is less area specified for this cross-

section 

3. Increase the waterline width so that there is more room off to the sides 

of the underwater ares 

4. Increase the depth of the kayak at this point. 

We are going to deal with this just by changing the Draft (option 4). Go to 

the Design menu and choose the menu item Sideview. Move the location 

slider to the point 180 so that we can see what we are doing. Start clicking 

on the up arrow near the Draft data entry box to increase its value. 

Increasing it by just 1mm is enough. Let’s increase it to 10.5 cm. Now take 

the slider and look back and forth along the kayak to see its cross-sections. 

Everything looks ok. 

To visualize the kayak from other perspectives, go to the Visualize menu 

and choose the Slice menu item. The kayak is shown from multiple 

perspectives, looking from above at the deck, from the bottom at the hull, 

and from the side. Moving the sliders changes the density of the slices 

represented. Move the bottom slider (the one that controls the side view) to 

50 mm and take a look at the side with the least density of lines. 

Alternatively one can move it to 10 mm and see a considerable density of 

buttock lines. From the pop-up associated with side view, choose Contour. 

This will create a colorized version akin to what one might see on a typical 

contour map with the oranges and reds reflecting higher values.  
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To really have fun, go to the Visualize menu and chose the 3D menu 

item. Here you can cloak your design with a variety of colors and view it 

from a variety of angles. 

Save your work to date by going to the File menu and choosing Save. 

A kayak has been designed which bears considerable similarity to the 

Keeowee kayak. Building kayaks is very labor-intensive and there's really 

not much point in simply replicating another design, in particular a rubber 

ducky design like the Keeowee which is cheap and made of a nice plastic 

suitable to its genre. What is the pleasure in that? The interesting part about 

designing a kayak is customizing it for your needs.  

I love my Keeowee kayak, but on days with a slight chop I tend to get wet 

because I am heavy enough that the bow of the boat tends to bury itself in 

the chop and water slops into the cockpit. The Keeowee is a type of kayak 

that one wants to paddle without a spray deck. It's great advantage is that it's 

easy to carry and it is easy to throw in the water and, with its giant cockpit, it 

is easy to get in and out. I don't want to use a spray deck with this kayak. I 

also prefer my kayaks to have more overhang that is characteristic of the 

Keeowee. I also want it to track a little better. Now is the time to do some 

additional customization. The first thing I'm going to do is to increase the 

height of the deck at the bow.  
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 From paddling the Keeowee in the conditions that I am concerned about, 

I might decide that I need an additional 10 cm of height at the bow. Go to 

the Design menu and select Sideview. Make the Bow Seam Height an 

additional 10 cm, so enter 30. The deck height at the bow was automatically 

adjusted but lets fiddle with that a little and make the Height 31 at the 

Location 1. To make the kayak track better, I am going to increase the depth 

at the stern. In the Shape Rocker group box change the Stern to 200. 

Go to the Design menu and select Birdview. Here is where we can 

increase the flair of the sides a little by making more of an overhang. 

Increase the Maximum Seam Width to 78. In the Shape Seam group box, 

increase the Bow to 45 and the Stern to 85. Use the slider to look at the 

cross-section at location 335. I don’t like how flat it is at the waterline so go 

to the Stern parameter in the Shape Waterline control box and change it to 

65. 

Now I am happy except at about position 170 there is a little convexity to 

the hull deck junction that I do not like. Go to the Tool menu and select the 

menu item – Constrain Cross Section.  Here use the checkbox to activate 

Underwater Angle Constrained, which is in the Side Angle Constrains 

Underwater group box. That does what I need, just a little touch up there. 

The graphic in Green, on the right side of the diagram, sort of explains what 

is happening. The vertical angle at the waterline is being forced in slightly 

by the requirement that the water angle be less than the angle formed by a 

line between the water and the seam line. This is a subtle change so look 

closely. On most of the sections this has no effect because the underwater 

sections do not approach the vertical, but it slightly pushes in the underwater 

sides at some of the midsections near location 170. 
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I am almost done but looking at the location 176 I might think that it is a 

little too squared off. I would like to reduce this. I know that if I increase the 

depth of the kayaks slightly, since the cross sectional area will remain 

constant, that should create a bit more of an arch and less of a squared off 

shape to the underwater contour. Go to the Design menu and select 

Sideview again. Tweak the Draft a little bit by adding 2mm. It is now 10.7. 

Now I am happy.  

Once you are making changes of only a mm or two, you realize that you 

are basically done. 

I might go to Visualize menu and select Slice or 3D and look at the 

kayak. I might go to the Design Cross-Section and look at it some more. 

But I am done. Perhaps when I actually build the kayak I might add a little 

bit of a keel at the end, but I can address little details like that at the time of 

construction. 

Go to the File menu and Save the design. One of the great advantages of 

designing a kayak on a computer is that it is easy to compare one design 

with another. Many people find kayak design and building a rather addictive 

hobby and, as the imperfections of one design become evident in use, the 

desire to refine the kayak arises. It is useful to have complete documentation 

of your earlier design so that one can make the appropriate changes to 

improve your next design. Great kayaks are designed by evolution. 

To actually build the kayak you need the cross-sections printed out. Go to 

the File menu and select Output…. First decide how many cross-sections 

you need. I've decided to create a cross section at every 15 cm all along the 

length of the kayak. Inside the Specify Cross Section(s) group box is a 
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button and titled Entire. Click that to specify cross sections that cover the 

entire length of a kayak. Increase the Interval to 15 and make the Start 5 to 

create a total of about 23 cross sections of the kayak.  

The next task is to create the Bearboat print file that can be utilized by the 

utility program BearboatPrint to actually print out the cross sections. At this 

time some people might want to make a model of the kayak. I could by 

changing from Life-size to a smaller size in the Scale group box. However I 

am willing to simply plunge ahead with building the Kiwi so I want to make 

a life-size printout. I'll be using cedar strip that is a quarter of an inch thick I 

would like the printed out cross sections to accommodate to this thickness. 

Check the Skin checkbox. Use the little arrows to specify a value of 6 mm., 

which should be sufficient to accommodate the thickness of the cedars strip. 

Once these parameters have been selected, click on the Print File button. A 

message will appear confirming that a text file has been created capturing 

the cross-sections that have been specified. The name of file also will 

include the name of the kayak and will be prefaced with numbers that 

indicate when the kayak design was printed all (YYMMDDHHMM). It will 

also contain the moniker BBPF. (BearBoatPrintFile) This file will end up in 

a folder called BearboatPrint. 

What good does this file do? No much unless you have the utility program 

BearboatPrint, which is also available for free at the web site. This is a 

separate program that handles printing out the cross-sections. This program 

only runs on Windows machines so Mac users have to find a friend, if they 

have one, who owns a Windows machine attached to a printer to actually 

create the paper printouts. Fire up the program BearboatPrint and select the 

BBPF file that you have just created. Then click on the print button of the 



 104 

BearboatPrint program and your cross sections will be produced, ready to be 

used to create the cross sectional forms that are needed for construction of 

your plug or your cedar strip kayak.  

This concludes the tutorials. There are many other functions of the 

program that you can learn by playing with it and going through the short 

manual and simply trying things out. 
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Final Comments 
This manual covers most of the highlights, but to learn the program you 

have to use it. Feel free to push buttons and try anything that you want. This 

is the way to come to a better understanding of the program. There is 

nothing in this program that is particularly difficult. 

Remember to save some time for paddling. 

There are various aesthetic problems that will rise using Bearboat Pro 

under the Macintosh OS 9 system and under Windows because the primary 

development environment is Mac OS X. These problems can generally be 

regarded as a minor nuisance. As the program matures, I would like to 

“clean up" the appearance of Bearboat Pro on these alternative operating 

systems. Some obvious annoyances are that the Quit command in Windows 

appears under the “wrong” menu and with the Windows version 

occasionally graphics have to be prodded to redraw. 

Keep an eye on the Web site 

www.homepage.mac.com/rlivingston 

for updates of the programs. 
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